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INTRODUCTION

Welcome to Freeway 2.0, the most accessible way to create professional-
looking Web sites! This public Beta version is designed to let you experi-
ence just how easy it is to design and build quality Web sites, using the
familiar user interface of a desktop publishing package.

This New Features Guide is the first draft of the user documentation
designed to accompany 2.0. The finished product will ship with a full 250-
page printed manual, and this document is only the very first rough of
some of that material. This guide is not designed to explain all of the
features of Freeway - for basic references, please use the Freeway 1.0
User Guide, and please be patient with differences in the functionality
documented there and what you will find in Freeway 2.0.

A revised version of this New Features Guide will be available shortly - if
you have subscribed to the Freeway 2.0 Preview mailinglist, then you’ll be
notified of new versions as they appear.

We hope you enjoy using Freeway 2.0!

ABOUT THE FIRST VERSION

Freeway 2.0 is a comprehensive update to the first version, which broke
new ground for Web publishing by introducing the first really user-friendly
interface for a Web authoring tool.

It also integrated much of the additional tasks which are involved in the
Web publishing workflow, primarily graphic processing and production.

Freeway is the only Web publishing tool which allows you to drop in the
graphics of your choice with the confidence that they will be exported in
the correct format for the Web, and offers you the ability to preview and
fine-tune the exported graphics to a professional standard.

It’s the only Web authoring package which gives you the ability to create
graphic text right there on the page with the same level of typographic
control as professional DTP.
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It’s the only Web authoring tool which allows you to design pages the
way you want and automatically creates output to recreate what you’ve
done on the page - even handling overlapping objects in a way that can
be viewed in all HTML 3.2-compliant Web browsers.

It’s the only Web publishing tool to offer you a full range of drawing and
layout tools, including a pasteboard, guides and rulers, distribute and align
objects, zoom from 5% to 1000% magnification, master pages, graphic
editing and transformation commands including crop, pan, rotate, scale,
reflect and skew.

NEW IN 2.0

With Freeway 2.0, we're raising the ceiling on functionality for our
customers. Boasting a greatly enhanced feature set including up-to-the-
minute HTML 4.0 technology, Freeway 2.0 allows its users to slip effort-
lessly into high gear, and tackle an even broader range of Web design
work with confidence and ease.

HTML 4.0 LAYOUT USING LAYER ITEMS

Layer items offer even greater layout flexibility and design control, and
can be used to stunning effect in cutting-edge Web design. Freeway now
supports the latest standards for object positioning on Web pages,
allowing any object to be specified as a layer item for output. This enables
Freeway customers to take greater advantage of the capabilities of the
version 4.0 Web browsers and to have more flexibility in their Web
authoring.

HTML 4.0 CASCADING STYLESHEETS

With Cascading Style Sheets (CSS), real typographic control over HTML
text is now possible - users will now be able to precisely control letter
and word spacing, indents, leading, type size and justification, and exploit
new text effects for more interactivity.

Freeway 2.0 will offer the most intuitive and accessible way for Web page
designers to work with CSS formatting through its award-winning DTP-
style interface, which already offers a comparable level of typographic
control for graphic text created within Freeway.
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Freeway now offers support for CSS in two modes:

• a real-world compatibility mode which offers conventional HTML text
formatting for older browsers, combined with CSS formatting to offer
maximum typographical control over HTML text.

• a true HTML 4.0 CSS mode, in which all HTML text formatting is
carried out using CSS style sheet attributes.

The compatibility mode creates hybrid pages which offer the flexibility
and control of CSS, and yet degrade more gracefully than pure CSS
when viewed in older browsers.

FREEWAY ACTIONS TECHNOLOGY

Freeway Actions allow Freeway's functionality to be extended by HTML
developers by making it possible to add and use new HTML features
through a simple yet powerful Freeway Action scripting language. This
scripting language is the key to the almost unlimited potential of Freeway
Actions because of these key characteristics:

• Complete flexibility over how and where the new HTML output is
to be inserted into the output HTML page

• Allows user input to be used to customise the HTML generated

• Create editable text fields, popup menus and file selector dialog
boxes for user input in the Inspector palette

• Pre-defined variables for date, time, filenames etc

• Simple, easy to learn language.

FRAMES SUPPORT

Frames allow users an exciting extra dimension in designing your Web
sites, by making it possible to display two or more pages in the same
browser window. Advantages include better site navigation, structure,
branding and maintenance, as well as additional design possibilities. Not
only does Freeway 2.0 allow users to create and work with frames in
their documents, but it also allows them to view and edit the source
pages live while working within the frameset page.
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TABLES SUPPORT

Tables are used in Freeway's output to organise and control the position
of the elements on the page - Freeway 2.0 adds to this the ability for the
user to define their own tables, to better organise and present tabular
information.

ANCHORS

Anchors allow users to link to a particular part of a page, making it easier
for their site's visitors to navigate and get to the information they need.
Anchors may be used to develop linked "tables of contents" for long
pages, to allow instant access to each section.

UPLOAD

Freeway already makes quality Web page design more accessible and
easier than any other package - now, publishing the site to make it live on
the Web is just as easy, using Freeway 2.0's upload facility. Users proof
their site to a local folder, then when they're happy with it, upload the
site with one command to their Web space - Freeway 2.0 allows them to
upload either using FTP over the Internet or to mounted volumes across
a local network, to suit the way they work.

FLEXIBLE LAYOUT

Freeway 2.0 gives users even more design freedom by allowing them to
define flexible page elements that stretch to take up unused room in the
browser window. Automatic page centering and right alignment, com-
bined with flexible items, mean that they can create Web pages that truly
react to their environment.

INLINE ITEMS

Freeway has always allowed users to make certain words (or even
paragraphs) in HTML text into graphics, which are then embedded in
place and flow with the text. Now, with Freeway 2.0, we've extended this
facility, so that users can insert almost any sort of object into a run of
text as an inline item. Now, graphics, form controls and multimedia
elements can be embedded into text stories, offering new creative
possibilities which include accurate wrapping of HTML text round
graphic items.
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HTML IMPORT

Customers with existing sites in HTML will welcome the ability in
Freeway 2.0 to import and convert HTML pages to recreate these in
their Freeway document. A wide range of HTML content and formatting
are supported, so that converting an existing site into a Freeway docu-
ment is now easier and more straightforward than ever.

PNG SUPPORT

With Freeway 2.0, we're looking to the future of Web design as well as
the present. Part of that future is a new graphics format called PNG - it
isn't widely supported now, but that will change as time goes on, and the
ability to use PNG on Web sites will become an increasing advantage.
PNG offers many of the same benefits as GIF for small, platform inde-
pendent images, plus additional advantages such as partial transparency.
Freeway 2.0 supports PNG for both import and export, so users will
have this capability when they need it.

SEPARATE FOLDERS WITH RESOURCES

Freeway has always let users structure their site using hierarchical folders
to organise their pages - now, with Freeway 2.0, they also have the ability
to control where the resources needed by their HTML pages are
published to in your site. Users can choose from saving all the resources
for their site (including graphics, multimedia content and so on) in a single
folder at the top level of their site, in a separate resources folder in each
folder in their site, or loose beside the HTML files themselves.

DISTRIBUTE COMMAND

Freeway 2.0 now allows users to space a selection items evenly or a
fixed distance apart, using the new Distribute command. Users can even
space items evenly across the page using an automatic option.
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2.1 HTML 4.0 LAYER ITEMS

In Freeway 2.0, it is now possible to use some of the new features of
HTML 4.0 to create even more exciting, dynamic Web pages. The two
main areas are Cascading Stylesheets (CSS), which offer more formatting
options for HTML text, and layer items, which extend the possibilities
available for page layout.

When creating a document or working on a page, you can now decide
whether or not you wish to use these advanced features. When you
want to use one or both of them, you need to set the HTML level for
the page or document. There are three options you can choose from for
the HTML level:

3.2 - This is the basic level, and should be used for standard Web design
work

Layout - invisible layout table

HTML text formatting - basic only

3.2+CSS
 - This is a more advanced level, which adds CSS text formatting
options to the basic selection. Use this when you want to have more
control over HTML text formatting than you have with 3.2 alone.

Layout - invisible layout table

HTML Text formatting - basic plus additional CSS attributes

4.0 - This is the advanced level, which allows you to set items on the page
to be output as layer items. All text formatting is done using CSS
attributes. Use this level only when pages are to be viewed in
version 4.0 or later Web browsers.

Layout - invisible layout table, layer items

HTML Text formatting - Entirely CSS
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Because using the more advanced levels of HTML functionality restricts
the audience, it may well be worth considering providing alternate pages
that use the basic HTML 3.2 features in addition to pages which use the
more advanced HTML 4.0 features. You can either have visitors select
which pages they wish to view, or use some sort of automatic detection
to find out what functionality they have in their Web browser, and supply
the correct page automatically. This sort of detection can be done using
scripting in your pages, or using special scripts on the Web server which
will be hosting your site.

LAYER ITEMS

Introduction

Layer items offer additional layout possibilities, but also have their own
restrictions, compared with the normal way of recreating your layout
from Freeway. In order to understand the strengths and disadvantages of
layer items properly, you need to know how Freeway recreates layout
normally.

When you draw items on the Freeway page, these items form a layout
that is reproduced in HTML when you publish your site. To recreate your
layout in HTML, Freeway creates an invisible layout table, consisting of
rows and columns that combine to create table cells. Every box drawn in
Freeway corresponds to a table cell in the output.

The contents of the item are output in that layout table cell. Graphic
items are output as GIF, PNG or JPEG. HTML text is output as real text
incorporating HTML formatting tags. Because everything is output into a
cell in this two-dimensional grid, it is not possible to have the contents of
two different cells overlapping one another in the output.

This is why, when an HTML item in Freeway overlaps a graphic item, the
HTML item has to cut up the graphic item and the part of the graphic
item that's behind it can't be displayed. It's why any item overlapping with
HTML text causes that text to reflow away from it. It's why to output
two overlapping graphic items Freeway has to combine them into one
new graphic in the output.
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Advantages of using Layer items

All normal items on the Freeway page will output as part of the layout
table, and therefore suffer from the resulting restrictions. However, layer
items are output differently - they float above the layout table in the
HTML output, and their position relative to the top left hand corner of
the browser window is fixed.

This difference makes layer items extremely useful for layout. Their
position on the page can be recreated in the browser window absolutely,
without requiring an invisible layout table to hold them in place. They can
overlap each other without requiring other items to reflow, be cut-up or
combine with them.

There is another advantage to setting the HTML level for the page to 4.0:
when this HTML level is selected, items on the page may be positioned
tight against the top and/or the left edge of the browser window.
(Normally, there is an 8 pixel offset which causes an unpleasant gap
between items and the edge of the browser window.) Both normal items
and layer items share this advantage when the HTML level is set to 4.0.

WARNING: When non-layer graphic items are positioned in the 8-pixel
offset area, the hotspot area of any hyperlinks attached to them will be
incorrect when viewed in NN4, offset by 8 pixels across and down.
When applying links to non-layer graphic items be careful not to position
them in this 8-pixel offset area, or make them layer items instead. This
applies equally to links applied to map items over a graphic item, or links
applied to graphic items directly.

TECHNICAL NOTE: This positioning is possible because the hidden lay-

out table is enclosed within a fixed position DIV container of its own,

which positions the layout table at the top left corner of the browser win-

dow.
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Finally, because individual layer items are individual objects in the HTML
output, they offer tremendous scope for adding animation and
interactivity to your Web pages by scripting their behavior using
JavaScript. For example, a layer item may be animated so as to appear
from the edge of the screen and move across the screen in a particular
path.

NOTE 1: Using layer items for layout is also regarded as "better" Web

design technique than using invisible layout tables, since their use

shouldn't cause any problems for unusual browser software. For exam-

ple, the screen reader software used by visually impaired people may

become confused when it encounters a layout table. As more and more

Web users adopt the 4.0 and later browsers, the present need for Web

designers to use tables for layout will decrease.

NOTE 2: Freeway outputs layer items using CSS-P container elements,

specified with the <DIV> tag and absolute position. Netscape's propri-

etary <LAYER> tag is not used.

Browser Restrictions

Currently only Microsoft Internet Explorer and Netscape Navigator 4.0
or later will display layer items correctly. When using other browsers or
browser versions than these, the contents of the layer items simply
appear one after another vertically on the page, in the order that they
are defined in the HTML. This considerably limits the audience who will
be able to view the page with the layout as it was intended.

It is sometimes desirable to construct a different version of a page
without the layers, so that people visiting the site who aren't using one of
the 4.0 browsers see a more reasonable presentation. You can use
browser redirection to automatically take visitors with up-to-date
browsers to pages that offer enhanced functionality such as support for
layer items.
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Before you can start to define items on the page in Freeway as layer
items, you need to set the page HTML level using either the Document
Setup command or the Page panel of the Inspector palette. Once the
HTML level of the page has been set to 4.0, you can then select any item
on the Freeway page and set it to export as a layer item. Any items on
the page which are not defined as layer items will be output using a
hidden table for positioning.

NOTE: The method used to define items as layer items means that they

will be drawn at a particular offset across and down from the top left

hand corner of the browser window when viewed in HTML 4.0-savvy

browsers. Although other items on the page can be set to appear centered

or aligned right in the browser window, layers will always retain their

fixed offset from the top and left. Using fixed position layers in conjunc-

tion with non-layer items in centered or aligned right pages can lead to

unexpected layout results in the browser.

To allow layers to be referenced in Freeway Actions or in Javascript, they
are output with an ID tag in the HTML. This ID will be derived from the
item Title shown in the Item panel of the Inspector when the object is
selected.

Combining graphic layer items

Freeway offers exceptional flexibility in how items can be output. For
example, two overlapping graphic items in Freeway can be output as:

o a single merged graphic positioned using a hidden layout table
(HTML 3.2)

o a single merged graphic output as a layer (HTML 4.0)

o two independent graphics output as two separate layers (HTML
4.0)

o independent graphics positioned using a hidden layout table (HTML
3.2)
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How the graphics are output depends firstly on the page HTML level as
discussed above, and secondly on the status of the Combine option for
each of the graphic items on the Freeway page. When graphic items are
set to Combine, they will be merged into one new combined graphic for
output, whereas if one or both is set not to Combine, they will output as
two separate elements.

NOTE: two graphic layer items can not be combined if there is another

non-graphic item or a graphic item that is set not to combine interleaved

between them.

Setting the HTML level

The choices are HTML 3.2 (most compatible), HTML 3.2 + CSS (Stand-
ard output with CSS enhancements) and HTML 4.0 (Less compatible -
allows HTML 4.0 layers for layout and all type formatting is done in CSS).
You may set the HTML level for the document as a whole, or on a page
by page level.

NOTE: It is important to set the HTML level first when wishing to work

with layer items or CSS, as these options are not available unless work-

ing on a page that has a suitable HTML level set for it.

To set the HTML level for the document.

When creating a new document, choose the default page HTML level
desired from the HTML output popup menu in the Document Setup
dialog. You may use the Document Setup command on the file menu to
change this for the document at any time.

To set the HTML level for the page

Make sure nothing is selected on the page. The Inspector palette now
shows the page panel. Choose the desired level of HTML support from
the HTML popup menu in the HTML Features cluster.

Setting the behavior of items

Any item on the Freeway page may be set to output as a layer instead of
being positioned using the standard hidden layout table. Additionally,
graphic items may be set to output as individual images or combined into
one.
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By default, all items drawn on the Freeway page are positioned in the
output using a hidden layout table - this is what imposes the restrictions
on certain types of overlap between items, and why images are cut-up by
overlapping HTML text, for example.

When items are set to output as layer items, however, they no longer
form part of this layout table, and are freed from the restrictions this
imposed on them. Layer items may overlap each other without interact-
ing in any way, and are stacked in the HTML output in the same order
that they appear on the Freeway page.

The layout table, if it has to be output because of the presence on the
page of any non-layer items, is always the rearmost element in the
output. Layer items are always treated as being in front of the layout
table. It is therefore impossible for non-layer items to be output in front
of layer items.

HTML elements may be positioned with complete freedom when they
are set to output as layer items, and will not interact with each other in
any way. Their stacking order may be changed by using the Send to front
or Send to Back commands, or by dragging their icons in the Site palette
when this is set to Show Items.

Graphic items will not interact with overlapping HTML items when
either are set to output as layer items, and nor will two overlapping
graphic items interact with each other when only one is set to output as
a layer item. However, when two graphic items which are both set to
layer items overlap they will combine into one image for output unless
the Combine option is turned off for one or both.

Setting any item to output as a Layer item:

1. Set the page HTML level to HTML 4.0, either for the whole docu-
ment or for the page in question.

2. Select the item you wish to make a layer, and turn on the Layer
checkbox in the Export panel of the Inspector Palette. The item now
displays a small icon in its top left corner, visible if Outlines is turned
on in the View menu.
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Setting any graphic item not to combine with other o verlapping graphic
items:

1. Select the item you do not with to merge with other overlapping
graphic items

2. In the Export panel of the Inspector Palette, turn off the checkbox
beside the Combine option.

Referring to layer items in scripts or Actions:

When an item is output as a layer item, it is specified using a named,
fixed-position DIV tag. This tag indicates a document division, and the
contents of this can be treated as a unique object when writing Javascript
to affect the document contents.

The title of the item within Freeway is used as the name of the layer item
in the output. To set the name of the layer item to something of your
choosing, simply select the item and type the desired text into the Title
field in the Item panel in the Inspector palette.

Layout issues affecting layer items

When items in Freeway are output as layer items, they have slightly
different layout behavior from items that are output as part of the
standard layout table. Some of the issues are described here.

Fixed position

Layer items are defined in the output as having a fixed position from the
top left of the browser window. They cannot be output as centered or
right aligned with regard to the browser window, as items in the layout
table can. Although it is possible to set a page to be centered or right
aligned using the HTML Features Align menu in the Page panel of the
Inspector, this only affects the contents of the layout table, not any layer
items on the page.
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Vertical position

Items output as part of the layout table in HTML 3.2 and aligned with
the top of the page will normally have an offset of around eight pixels
from the top of the browser window. However, in HTML 4.0, items do
not need to have this offset, and so the top of the page will be treated as
the top of the actual browser window.

The same item will therefore appear to output in a different place with
relation to the top of the browser window, when the HTML level of the
page is changed.

Flexible width

Layer items are defined with a fixed width always, and cannot be set to
output with Flexible width as normal items can.

Overflow behavior

When there is more content defined to appear inside a layer item than
will fit when the output is viewed in a browser (e.g., if the browser font
preferences are set to a larger text size than normal), the layer item can
be set to handle the overflow situation in a variety of ways.

Overflow: Visible, Hidden, Scroll, Auto

The default is for layer items to expand if the contents grow to take
more space than originally allowed - this is the Visible option. However,
you can opt to have the overflow if any clipped to the original boundary
of the layer item - this is the Hidden option.

The Scroll and Auto options are not currently implemented in the
version 4.0 browsers available, but may be implemented in IE5 when it
ships. Scroll is meant to display scroll bars at the side of the layer item
which would allow the visitor to bring overflow information into view.
Auto is meant to display scroll bars too, but these would appear only in
an overflow situation, whereas when Scroll is used, they would always be
visible.

You can prevent overflows when HTML text is contained within Layer
items by applying a fixed point size to the text.
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2.2 CSS TYPOGRAPHY

With the introduction of the version 4.0 browsers, typography on the
Web took a considerable step forward because of the introduction of
cross-browser support for the new standard, Cascading Stylesheets (or
CSS). CSS is a standard devised to offer Web authors some of the same
type control found in desktop publishing and word processors.

Freeway offers the ability to use only CSS formatting for the appearance
of HTML text, in accordance with the guidelines set out in the HTML 4.0
specification. However, one problem with using only CSS formatting is
compatibility with earlier browsers - unless visitors are using Explorer 3.0,
Explorer 4.0, Navigator 4.0 or later versions of these, they will not be
able to see any of the CSS formatting, and will see only unformatted text.

Because of this, Freeway also offers the ability to mix CSS and HTML 3.2
formatting attributes in a special compatibility mode. In this mode, CSS
extended attributes are available as well as the normal attributes of
HTML text. When applying formatting in the output, Freeway will use the
HTML 3.2 method of formatting rather than the CSS method wherever
possible. It will only use CSS when necessary in order to implement
formatting not normally offered in HTML 3.2.

This means that when pages are viewed in CSS-savvy browsers, both the
conventional and CSS formatting should be displayed. However, when
the pages are viewed in non-CSS-savvy browsers, the CSS formatting will
be ignored, but the conventional HTML 3.2 formatting will be displayed.
This means that the formatting applied to HTML text will not be totally
lost when visitors are not using the most recent browsers and versions.

In order to access either full CSS formatting or the compatibility mode, it
is necessary to set the HTML level for the page you wish to use the
formatting on. You may set the HTML level on individual pages, on master
pages or for the document as a whole. To set the level for a page or
master page, use the HTML popup on the Page panel of the Inspector
palette. To set the level for the document, use the HTML Output popup
menu in the Document Setup dialog. The default page HTML level is
HTML 3.2.
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Setting the page HTML level to HTML 4.0 will cause all text formatting
to be output using CSS, and also allow individual items to be output as
HTML 4.0 layers. Setting the page HTML level to HTML 3.2+CSS
activates the compatibility mode - HTML text may be formatted with the
extended range of CSS attributes, but output will use HTML 3.2 com-
mands wherever possible for backward compatibility.

When using CSS formatting options, it is vital to be aware that not all of
the attributes on offer are supported by both browsers. In addition,
some attributes may cause a different result in the two browsers. In the
description of the attributes that follows, any differences in browser
support will be highlighted. As always, it is essential to test your pages in a
variety of browsers to prevent unpleasant surprises.

CSS FORMATTING AVAILABLE

CHARACTER ATTRIBUTES

Font

Font Sets defined in Freeway may be applied using CSS just as in HTML
3.2. In addition, you can add the following terms to the end of the list of
fonts in font sets defined in Freeway to automatically select a default serif
or sans-serif font; "Serif" and "Sans-serif". E.g. "Verdana, Geneva, Arial,
Helvetica, Sans-serif".

Size

HTML text may be given a size using a variety of units. HTML text is no
longer restricted to the relative sizes, although these may still be applied.

Points - you may specify any size in points using numeric values

Relative sizes - you can specify a size relative to the base font size set in
the browser.

Named sizes - you may specify text as being XX-small, X-small, Small,
Medium, Large, X-large and XX-large.
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Style

Type styles available for HTML text now include plain, bold, italic, under-
line, overline, strikethrough and blink. [Blink is NN only, Overline is IE4
only]

Color

HTML text color is set using RGB values. You can choose from the
custom color list in Freeway, from the Net safe color picker, or from the
Apple system pickers.

Shift

You can apply three degrees of sub- or super-script using the Shift
option.

Case

HTML text can have its case shifted using the following commands:
Capitalize (upshift first letter of every word), Upper Case (upshift all
text), Lower Case (downshift all text), Small Caps (upshift all text, first
letter of each word is larger size). [Small Caps produces no result in NN
and upper case in IE]

Background Color

The area occupied by the text can have a background color assigned to
it using this command.

Background Image

The area occupied by the text can have a background image assigned to
it using this command.

Letter Spacing

You can add or remove space between letters in HTML text. [IE4 only]

Word Spacing

You can add or remove space between words in HTML text. [IE4 only]

Cursor

You can choose which cursor shape appears over a certain area of
HTML text. The possibilities include: Crosshair, Text, Wait, Help, Auto, W-
resize, NW-resize, N-resize, NE-resize, E-resize, SE-resize, S-resize, SW-
resize. [IE4 only]
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Language

You may set the language dictionary that is used within Freeway for spell-
checking and hyphenation. (This does not set the character set that
should be used to render the text in the Web browser.)

PARAGRAPH ATTRIBUTES

Alignment

HTML text may be set to Left align, Centered, Right align or Justified.

Leading

The leading of HTML text may be set to any value desired, using either
percentage of text size, or fixed values in points.

Indent

Indent may be set using levels of Blockquote, or by using any value
desired. To set specific values, choose Other... from the menu.

Space Before, Space After

Space may be added between paragraphs by adding it before or after
each paragraph. You may specify any value in points.
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2.3 FREEWAY ACTIONS

Freeway Actions are simply text files which work by allowing HTML
authors to create HTML functionality (for example, JavaScript
rollovers).These elements can then be accessed from within Freeway by
even naive users, who need have no knowledge of the detailed workings
of the new functionality.

A new Freeway Action appears as a tool option in the Tools palette, with
which the user draws a box to create an Action item. When working
with such elements, the user can specify options for the Action using
Freeway's Inspector palette, and the information entered here is used in
the output for the Action. (For example, when drawing a rollover Action
item the user can specify which images are to be used for the
MouseOver and MouseOut events.)

For the Action authors, the control over the HTML output and the ability
to design an intuitive, visual interface for the new HTML functionality
make Freeway Actions extremely powerful and flexible. When defining
the Action, the author is able to define with precision where the various
parts of their HTML output code are to be inserted in the output HTML
file, as well as the interface for the Action options that will appear for the
user in the Inspector palette.

The Freeway Action language is simple and easy for HTML developers to
learn, and Action development is made even easier by the smooth
integration with the Freeway application. When developing a new Action,
the text file representing the Action is saved in a folder beside Freeway
and is automatically parsed and added to Freeway's interface the next
time Freeway becomes the foreground application. When fine-tuning the
Action, the author need only save any changes using their favorite text
editor and then switch into Freeway to find that Freeway will have
seamlessly updated the Action.
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In the Web design workflow, Freeway Actions can separate the coding
and layout tasks, easing Freeway's integration into existing workgroups.
Key advantages are that non-technical users can now easily use complex
programming in their Web pages, and the more technical users can
customise the supplied Actions as they wish. Actions also offer the similar
benefits to Master pages for the development and maintenance of
scripting, because the developer only has to maintain one instance of the
code in the Freeway Action text file instead of managing multiple code
fragments across every page. Changes to a Freeway Action are automati-
cally incorporated when documents are opened and published.

Applications for this new technology include database connectivity,
Javascript, animation, ad banners and counters, as well as much more. A
selection of Freeway Actions will ship with Freeway, and a growing library
of new Actions is planned to be available for download free of charge.
We also anticipate that users will design and share their own Actions.

FREEWAY ACTIONS

Freeway Actions provide the means to encapsulate and manipulate the
HTML which Freeway will output. The initial thinking behind Freeway
Actions was to enable building of online web applications in Freeway
while maintaining separation between the programming required and the
way the site looks.

Freeway Actions are defined in ‘TEXT’ files. To make a Freeway Action
accessible from Freeway it has to be placed in a folder called “Freeway
Actions” in the same folder where the application itself resides.

Note: The Freeway Action folder cannot be an alias.

Freeway Actions can be drawn onto a Freeway page using the new
Freeway Action tool in the Tools palette. Pressing and holding the mouse
on the Freeway Action tool longer than around 1/3 of a second will
open up a menu displaying all Freeway Actions available. Once an Action
has been chosen from this menu, this becomes the default Action that
will be used if the Action tool is selected.
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The Tools palette displays the name of the current Freeway Action when
the Action tool is selected.

Another way to add an Action item to a document is using the Insert/
Action menu.

There is a new inspector panel for Freeway Actions which currently will
display the type of the Action as well as any user parameters which the
Action will process.

Freeway checks whether the modification date of Freeway Actions is
changed whenever Freeway is being switched into. If any file is changed it
will be reinterpreted and Actions which are no longer available will be
marked with an underline in both Action menus.

The definition of Freeway Actions is saved with the Freeway document.
That way if the definition is not available when the document is opened,
the document will still publish properly. Placing the original Freeway
Action file in the Freeway Actions folder will restore the connection.

Freeway Actions may show as either items with a little Freeway icon
followed by the type of the Action or, if defined by the Action, as
checkboxes, radios, textfields, lists, textareas or buttons.

The names of the Actions are displayed in the startup dialog when
Freeway is launched.

The error list dialog may be displayed in case errors were found while
loading the Freeway Actions, either on startup or when switching into
Freeway.

FREEWAY ACTION FILE FORMAT

The <WAY OBJECT> / </WAY> tags are optional and can be used to
define multiple Actions and their parameters within one text file. If no
WAY OBJECT is given then the user visible name will be the file name
itself.

<way object NAME{:PREVIEWTYPE} {width:N} {height:N}
{PARAM{:TYPE}} {PARAM{:TYPE}} ...>



25
1. INTRODUCTION 2

1.1 ABOUT FREEWAY 1.0 2
1.2 NEW IN 2.0 3

2. NEW FEATURES
2.1 HTML 4.0 LAYERS 8
2.2 CSS TYPOGRAPHY 17
2.3 FREEWAY ACTIONS 22
2.4 HTML IMPORT 28
2.5 FRAMES 30
2.6 TABLES 48
2.7 ANCHORS 61
2.8 UPLOAD 66
2.9 FLEXIBLE LAYOUT 75
2.10 INLINE ITEMS 82
2.11 SEPARATE RESOURCE

FOLDERS 84
2.12 PNG SUPPORT 86
2.13 DISTRIBUTE COMMAND 88

Freeway 2.0 NFG - Version 1.0. 17th July 1998

FREEWAY 2.0 NEW FEATURES GUIDE

OBJECT_DEFINITION

</way>

• All keywords are case insensitive.

• NAME has to be enclosedin double quotes if it contains spaces.

• The currently supported PREVIEWTYPEs are checkbox, radio, button,
textfield, list, textarea.

• If no PREVIEWTYPE is specified then width: and height: will define the
natural dimensions for the Action.

• There can be 0 or more PARAMs. They will be added to a new panel
within the inspector palette. The parameter name needs to be
enclosed in double quotes if it contains spaces.

• TYPEs currently supported include popup and file:

popup

The keyword “popup” can be followed by any number of strings sepa-
rated by colons which will be added to a popup in the inspector
palette. The first item after the popup keyword will be the default
value for the parameter both on output and on the panel. For
example:

<way object “QuickTime” “Loop:Popup:Yes:No”>

file

The file parameter type creates a Select button. Clicking this button
brings up the standard file selection dialog box, where the user can
navigate to and choose a file on any mounted volume.

The files viewed in the file selection dialog box may be filtered by adding
the file types that you wish to be available when browsing. Files with
different file types to those specified will not be visible.
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To add file types to be visible in the dialog, simply list them after the term
file and a colon. Use colons to separate file types. File Types are case
sensitive. For example, the following code will create an Action called
Quicktime and a button labelled Source (select) which can be used to
browse for files, but only files with the file type of MooV will be visible in
the dialog:

<way object “Quicktime” “Source:file:MooV”>

• OBJECT_DEFINITION is defined as follows:

{<way POSITION>}MARKUP{</way>}MARKUP

• POSITION can be any of the following (and where in the HTML they
will be inserted): before-start-html (before <HTML>), after-start-
html (after <HTML>), before-start-head (before <HEAD>), after-
start-head (after <HEAD>), before-end-head (before </HEAD>),
after-end-head (after </HEAD>, before-start-noframes (before
<NOFRAMES>), after-start-noframes (after <NOFRAMES), before-
start-body (before <BODY>), after-start-body (after <BODY>),
before-end-body (before </BODY>), after-end-body (after </
BODY>), before-end-noframes (before </NOFRAMES), after-end-
noframes (after </NOFRAMES), before-end-html (before </
HTML>), after-end-html (after </HTML).

• MARKUP is defined as {ANYTHING}{<$PARAM$>}{ANYTHING}.
On output, when <$PARAM$> is encountered within MARKUP it is
substituted with the actual value of the parameter as defined by the
user or using the default value.

• PARAM can also be: “_width” (width of item), “_height” (height of
item), “_title” (title of item).

• ANYTHING can be any text.

Built-in Variables

Built-in variables include:

_width : width assigned to object in Freeway

_height : height assigned to object in Freeway
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_date : date object was last published

_time : time object was last published

_title : title assigned to object in Inspector

_link : link assigned to object including "href="

_pagetitle : title assigned to page containing the object

_pagefile : HTML file name assigned to page containing the object

ERRORS REPORTED

Illegal preview type ignored. Please use checkbox, radio, button, textfield,
list or textarea.

Missing </way> tag added.

Too many </way> tags in file. Extra </way> ignored.
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2.4 HTML IMPORT

INTRODUCTION

With Freeway 2.0, it is now possible to import existing HTML pages into
Freeway. Freeway will create a new page in the current document, and
import as much of the contents and formatting of the HTML page as
possible.

This feature will give a head start when importing legacy sites for use
within Freeway - however, it is important to note that because Freeway
does not work directly in HTML, this is a conversion process which is
unlikely to result in an exact functional replica of the original site. You
should expect to have to do further editing and fine-tuning work after
importing your HTML pages, and the amount of work required is
dependent on the structure and features used in the external HTML.

A comprehensive list of the HTML tags and attributes supported is given
below.

IMPORTING AN HTML PAGE INTO FREEWAY

There are two ways of importing HTML into Freeway; importing into an
existing Freeway document, which adds a new page based on the HTML,
and dropping an HTML file on the Freeway application icon in the Finder,
which creates a new default document based on that HTML file.

To import an HTML page into an existing document:

1. Open or create a new Freeway document

2. Choose Get HTML from the File menu

3. Locate the HTML file you wish to import and click Open.

Freeway will create a new page in your document, based on the default
settings in Document Setup, and import the contents of the HTML file
into boxes on the page.

To convert an HTML file by drag and drop:

1. Locate the Freeway application icon in the Finder

2. Drag and drop the HTML file you wish to convert onto the Freeway
icon.
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Freeway will create a new document based on the default settings in
Document Setup, and import the contents of the HTML file into boxes
on the page.

WHAT’S SUPPORTED DURING HTML IMPORT

Text, with most text formatting intact, graphics and other resources
referred to in the HTML are imported, as are page settings, scripts in the
<HEAD> of the HTML file, forms and framesets. Remember to test the
resulting output from Freeway thoroughly, even if your page appears to
have been reproduced correctly, in case any minor attributes have been
overlooked.
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2.5 FRAMES

INTRODUCTION

The ability to work with frames is a powerful and exciting addition to
Freeway’s feature set, which can offer some stimulating new possibilities
in the design of your Web site. Using Frames can enhance the perform-
ance, navigation and branding of your site when used well. On the other
hand, however, they can be unsightly and confusing for the visitor when
used inappropriately. They also have some unique disadvantages com-
pared with presenting your site without frames, which it is important to
be aware of.

WHAT ARE FRAMES AND FRAMESET PAGES?

Frames are essentially a different way of viewing individual HTML pages
using the Web browser. When viewing HTML pages normally (that is,
without frames) a single HTML page is viewed in a single browser
window. If you wish to view two HTML pages together, each must be
viewed in its own browser window.

Using frames, however, this one-to-one relationship between the browser
window and the HTML page changes. A single browser window may be
used to view two or more HTML pages at the same time, by using
commands to split the window into two or more parts. The parts
created by splitting the window are called frames, and it’s each frame that
then points at a single HTML page.

To define the way in which the browser window must be split and what
HTML pages should be displayed in each part, a special kind of HTML
page is used, called a frameset page. When viewed in a frames-capable
Web browser, this page displays no content of its own, but is simply used
to the define the way in which the window is split into frames, and which
further HTML page should be displayed in each frame to begin with.  This
information is called the frameset definition.
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The frameset page defines the number and orientation of the frames to
be created in the browser window, as well as information about how
each frame should behave. For example: • whether a border is to be
displayed between frames and its width

• whether frames are to be a fixed width, or a width proportional to the
actual width of the browser window

• whether to show scroll bars if there is more content than can be
displayed at a particular size

• whether a frame can be resized interactively by the Web site visitor

Here is a summary of the terminology:

Frame - part of a browser window which has been split to display
two or more HTML pages at the same time

Frameset - the container for two or more frames. Framesets may
be nested within each other to create complex structures.

Frameset page - an HTML page which contains one or more
framesets

Source page - the page that is displayed within a frame when the
frameset page is viewed in a Web browser.

The frameset page may also contain content that may be displayed by
Web browsers that cannot display frames. This is called NoFrames
content, and will never be seen by the majority of visitors, who will be
using frames-capable browsers. If you want to cater for people who
aren’t using frames-capable browsers, you can display some basic content
to still allow them to contact you, or even link them into a separate, non-
frames version of your site.
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LINKING WITHIN FRAMES

When the user follows a link contained in a frame, the default behavior
of the browser software is to load the new page into the same frame as
the link. This is usually the correct thing for it to do, but there are impor-
tant cases when something different should happen. Examples of when
this may not be appropriate are when links point to external Web sites,
or when separate frames are being used for navigation and displaying
content.

To allow the necessary control over this, there are two other important
ideas which are related to the use of frames; the naming of individual
frames, and the ability to target a link to load the new page somewhere
other than the frame in which the link appears.

Using link targeting, you can tell the browser that instead of replacing the
content of the frame containing the link, the new page should appear
somewhere else, such as a different frame in the same window, a new
window altogether, or replacing the entire content of the current
browser window.

In order to load the new page into a different frame in the same browser
window, you need to be able to tell the browser which frame is to be
the target of the link. To permit this, you can give any frame a unique
name so that it can be identified.

Once you have named a frame, you can specify that name as the target
when you specify links. You can specify a unique target for every link you
create. However, to save time and effort when several links on a page all
need to be targeted the same way, it is possible to set a “base target”
option for the page containing the links. This specifies that unless other-
wise specified, all links on that page should load into the given target.

BENEFITS OF USING FRAMES

As mentioned initially, good use of frame sets can enhance site perform-
ance, navigation and branding. They can also make site maintenance
easier, and be used to solve certain layout problems.
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1. Performance

When separate frames are used for displaying navigation or site branding
elements, separate from the content of the site, this can sometimes make
a site considerably faster to browse. This is because the elements that are
the same from page to page no longer have to be unloaded and re-
loaded as new content pages are visited. Content pages become smaller
and less complex as a result, and therefore download and render more
quickly.

2. Navigation

When navigation links and content are contained on the same page, this
can make it harder for visitors to navigate, especially if pages scroll
vertically so that the navigation links disappear out of sight. Using a
separate frame for navigation links ensures that even when scrolling in
the content frame occurs, the visitor never loses their navigation controls.

3. Branding

As with navigation, when branding elements such as company name &
logo are contained within a separate frame from the content, it ensures
that these elements are always kept in sight - reinforcing the corporate
identity and the user’s sense of where they are. When placing advertising
banners on a Web site, the same benefits apply if they are set in their
own frame - the advertiser’s message is kept in constant view, which
makes the advertising space more effective.

4. Ease of Maintenance

Using separate frames for navigation, branding and content makes it
easier to maintain a Web site. The pages that lie behind such frames act
in the same way that master pages do in Desktop Publishing and in
Freeway documents, so that elements which repeat throughout the site
can created once and subsequently reused. For maintenance thereafter,
changes need only be made in one place, instead of on every page.
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5. Layout advantages

When constructing a site using frames, they can be used to solve certain
layout problems that may cause difficulty otherwise. Examples are;
offering the possibility of true vertical and horizontal centering of page
elements within the browser window; cropping of page background
images to a specific size; using different page background colors within
different areas of the browser window; using different link colors within
different areas of the browser window.

DISADVANTAGES OF USING FRAMES

Although the benefits of using them can be great, frames can be time-
consuming to create and work with, especially at first. They may also be
confusing for new Web publishers. There are also other disadvantages
that must be understood and weighed against the benefits.

Sociological note: Using frames to construct a site goes against some of
the theoretical principles underlying the development of the Web as an
information space. One leading commentator on the Web is a strong
critic of the use of frames - read Jakob Nielsen’s views about how
“Frames suck most of the time” at http://www.useit.com/alertbox/
9612.html for an interesting and well-informed viewpoint.

1. Browser support

(a small proportion of visitors won’t be able to see your site)

Frames were originally a proprietary extension to the HTML language,
which became popular with end-users and Web site designers long
before there was any formal recognition of them in the HTML specifica-
tion. Initially, they were supported only by the Netscape browser, but are
now supported by Microsoft Internet Explorer and the AOL browser
too.

Statistically speaking, at the time of writing (early 1998) almost everyone
who visits your site will be using a frames-capable browser of some sort.
(Studies tend to indicate that between 95-100% of visitors to most sites
are using Netscape Navigator 2.x, 3.x or 4.x, Microsoft Internet Explorer
3.x or 4.x, all of which are frames-capable.)
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However, it’s worth remembering that in some browsers it is possible to
turn off the display of frames using the browser preference options. This
means that it is possible that even someone using one of the frames-
capable browsers may not be able to see your frames site if the display
of these has been turned off (whether by accident or intentionally).

Visitors who aren’t using a frames-capable browser at all may include
people using text-based or PDA-based Web browsers, visually impaired
people using “speaking” browsers, and people surfing with browsers such
as Lynx or Mosaic.

Web designers need to choose for themselves whether to decide against
using frames at all, provide alternate content or sites for these users, or
just ignore the issue altogether, based on the kind of site they’re designing
and the anticipated audience.

It often helps to see what other designers have done regarding this when
creating similar sites to yours and which use frames. One option is to visit
a few sites which are aimed at the same sort of audience as yours, and
simply view the source of the main frameset page in your Web browser
to see if there is NoFrames content specified. Or, obtain a browser like
Macweb or Explorer 2.0 that does not support frames, and visit a
selection of sites using this. A large number of major sites which use
frames offer no alternative content whatsoever, without seeming to
antagonize people.

2. URLs

(the current URL of the page you are reading no longer appears, and
can’t be bookmarked)

One of the great strengths of the Web as an information resource is the
ability to find any page you want at any time, using its unique address, the
URL. However, when browsing pages through a frameset instead of
directly, the browser location bar no longer displays the URL for the
actual pages being browsed - rather, it displays the URL for the frameset
page through which the content pages are being viewed. Bookmarking
this URL after following a few links, and returning to it later will restore
the pages that were in view initially, not the pages that were in view
when the bookmark was created.
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There are other problems related to this. In the original concept of the
Web, a page was a self-contained unit - it contained all the information
provided by the author regarding context, links and so on, so that when
you revisited a page you had been to before, you had the same options
and information available to you.

However, in a frames site where branding, navigation and content can be
split over different pages, this self-contained aspect is lost. Suppose you
did manage to record the URL for the actual content page you were
viewing, and returned to this page at a later date; all that you would see is
the content page itself, without the context of the originally accompany-
ing frames which surrounded it. In order to see exactly what you saw the
first time, you would need to start at the original frameset and proceed
through the same series of links.

3. Print problems

(framesets often don’t print properly)

Web browsers are notoriously bad at printing Web pages at the best of
times, but the additional problems which result from trying to print
framesets as you see them make it nearly impossible for the browser to
get it right. For example, should all the frames be printed or just one?
What should happen if you have more content than will fit contained in a
scrolling frame? What should happen if there are two or more frames
with scrolling content in view at the same time?

Where visitors are likely to wish to print the page contents experienced
Web publishers often provide alternate versions of the page, which have
been specifically designed for printing, to try to get around these prob-
lems.

4. Search engines

(entries for your site may be completely inappropriate)

When search engines are indexing a site, they often have problems
deciding what exactly to index in frames sites, and as a result inappropri-
ate entries may be referenced. To read some real-life experiences of how
one Web master got on with search engines and his frames-based site,
visit http://www.ehsco.com/opinion/19980209.html
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5. User preference

(some people just can’t stand frames)

Finally, although many people like visiting frames sites, especially sites that
use frames elegantly, there is a small but substantial group of people who
dislike their use. For some of them, the dislike is a rational one, based on
some or all of the reasons above; for others, it seems to be simply
personal preference. It’s worth remembering that not everyone may be
pleased to see a new frames version of your site, despite whatever
benefits it brings.

HOW TO CREATE FRAMESET PAGES WITHIN FREEWAY
2.0

Any page in a Freeway document may be made into a frameset page
with 2 or more frames. Each frame may point to either a page in the
same Freeway document, or an external HTML page. The page refer-
enced in a frame is known as the source page of that frame.

If the source page for any of the frames is not available when a frameset
page is rendered in the Web browser, the browser will display a dialog
box containing an error message.

The same source page may be referenced in two or more frames in the
same frameset page - this is often done when using empty HTML pages
(which usually contain nothing but a page background color) as fillers in a
layout designed using frames, for example. A source page will usually be a
standard HTML page, although it is possible for the source of the frame
to be another frameset page (creating nested framesets) or any valid
HTML object, such as a graphic or multimedia element.

To create a frameset page

To change any normal page in your Freeway document into a frameset
page:

1. View the page you wish to become the frameset page

2. Choose either Split Horizontal or Split Vertical from the Page menu.
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The normal page outline and pasteboard will disappear, to be replaced
by two colored areas sub-dividing the area of the document window in
two. These areas are the frames you have created. In the Site palette,
Frameset pages are differentiated from normal pages by a different icon.

If the page already contains content when it is changed into a frameset
page, this is not lost in the process, and if you remove the frames from
the page, the initial content will be restored. The original page contents
are output in the HTML as NoFrames content, which will not be dis-
played in frames-capable browsers, although they will be downloaded in
the background when the page is viewed, and add to the download time.

NOFRAMES CONTENT

NoFrames content is displayed when a frameset page is viewed using any
browser which is not frames-capable, such as Microsoft Internet Explorer
2.0, or when a frameset page is viewed with the option to display frames
turned off in its Preferences. There are two ways of creating NoFrames
content within Freeway. First, as described above, any content on the
page before it is made into a frameset page will be specified as
NoFrames content. Second, you may choose to edit the NoFrames
content by choosing View NoFrames Content from the View menu. This
hides the display of the frameset definition, and displays the NoFrames
content on the page, if any. Turn this command off again when you have
finished working with the NoFrames content and wish to restore the
normal frames view.

Some Web publishers do not specify any NoFrames content at all, but
this can be unfair to users of other browsers who visit your site. Without
NoFrames content being specified, visitors who come to your site with
browsers which are not frames-capable see absolutely nothing, not even
an error message.

On the each frameset page, you can define some NoFrames content
which at the very least alerts visitors without frames capability to why
they aren’t seeing your site.
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NoFrames visitors are also potential customers

It is considered bad form in the Web publishing world to make
NoFrames visitors feel unwelcome or to simply direct them to upgrade
to a browser of your choosing, not theirs. Despite this, many sites display
condescending messages informing the NoFrames visitor that their
browser does not support frames, and they should “upgrade” to Naviga-
tor or Explorer.

It is highly unlikely these days that any NoFrames visitor is unaware that
their browser does not support frames, and patronizing instructions
telling them to upgrade their browser do not go down at all well with
UNIX users, visually impaired surfers, or business people surfing using
PDA browsers.

At the very least, provide NoFrames visitors with an email address or a
link to follow. Alternatively or in addition, consider providing a page for
them to go to which includes essential basic information such as your
contact details - at least they can then phone, fax or email you with their
query. Adopting an apologetic tone in the NoFrames copy, rather than
sounding curt or condescending, is more likely to win friends in the long
run.

OPTIONS FOR WORKING WITH FRAMES

The necessary options for working with frames are located at the foot of
the Page menu, in the Inspector palette and in the Frames palette. Note
that there is a panel in the Inspector palette called the Frames panel,
which should not be confused with the Frames palette itself.

When on a frames page, the Inspector palette always displays the
Frameset Page panel, which has a different icon from the normal Page
panel. This panel allows you to give the frameset page a title, change the
filename which will be generated for the page, or change the width of
the border between the frames in the browser window.

When working with selected frames, you may also see the frames panel,
which contains the options for the selected frame and its enclosing
frameset.
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Finally, because you can edit the pages that are being displayed inside the
frames on a frameset page, you will see the Page panel for the page
being edited in the Inspector palette alongside the Frameset page panel:

• when you are editing text on the page viewed inside a frame.

• when you have objects selected on the page viewed inside a
frame.

• Once you have made a page into a frameset page

You may now:

• select any frame and specify a source page for it. The source
page may be another page in the same Freeway document, or an
external HTML page.

• split a frame so as to contain further frames nested within it.
Nested framesets contained within a frame do not need to have the
same orientation as their parent frameset.

• add more frames at the same level, creating a frameset with
three or more frames. Subsequent frames added to the same frameset
must share the same orientation.

• Change the orientation of the frames in the frameset

• Change the border width between the frames

SPECIFYING THE FRAME SOURCE
To specify an existing page in the same Freeway document as the
frame source:

1. Select the frame by clicking inside it. A selection marquee appears
inside the selected frame, and the Inspector palette displays the
Frames panel in addition to the Frameset Page panel.

2. In the Frames panel of the Inspector palette, locate the Frame: cluster.
From the Content popup menu, choose the page you wish to set as
the source for the selected frame.

3.The frame now displays the source page as its content. You may edit
objects on the source page as if you were viewing it as the current
page.



41
1. INTRODUCTION 2

1.1 ABOUT FREEWAY 1.0 2
1.2 NEW IN 2.0 3

2. NEW FEATURES
2.1 HTML 4.0 LAYERS 8
2.2 CSS TYPOGRAPHY 17
2.3 FREEWAY ACTIONS 22
2.4 HTML IMPORT 28
2.5 FRAMES 30
2.6 TABLES 48
2.7 ANCHORS 61
2.8 UPLOAD 66
2.9 FLEXIBLE LAYOUT 75
2.10 INLINE ITEMS 82
2.11 SEPARATE RESOURCE

FOLDERS 84
2.12 PNG SUPPORT 86
2.13 DISTRIBUTE COMMAND 88

Freeway 2.0 NFG - Version 1.0. 17th July 1998

FREEWAY 2.0 NEW FEATURES GUIDE

To create a new page to be the source of the frame:

1. Select the frame by clicking inside it. A selection marquee appears
inside the selected frame, and the Inspector palette displays the
Frames panel in addition to the Frameset Page panel.

2. In the Frames panel of the Inspector palette, locate the Frame: cluster.
From the Content popup menu, choose Other. The Frame Source
dialog will appear.

3. Choose the option New Page, and select the master page you wish
the new page to be based on.

4. Click OK. The New Page dialog will appear.

5. Type the title for the new page and click OK.

6. The frame now displays the source page as its content. You may edit
objects on the source page as if you were viewing it as the current
page.

NOTE: With any frame selected, you can use the Frame Content com-

mand on the Edit menu to set or change the source page for that frame.

You can also use the Goto frame content command to change from the

frameset page to the actual content page itself, if the content page is in

the same Freeway document.

To specify an external HTML page as the source:

NOTE: In order to do this, you need to know the file name of the HTML

page you wish to set as the frame source, and where it will reside with

relation to the frameset page you’re creating. To find out more about

specifying relative URLs to external pages, see the section on

XXXXXXXXXXX in the manual chapter XXXXXXXXXX.

1. Select the frame by clicking inside it. A selection marquee appears
inside the selected frame, and the Inspector palette displays the
Frames panel in addition to the Frameset Page panel.

2. In the Frames panel of the Inspector palette, locate the Frame: cluster.
From the Content popup menu, choose Other. The Frame Source
dialog will appear.
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3. Choose the option URL and type or paste in the URL for the external
page you wish to specify as the frame source.

4. The URL for the external page will appear in the frame against the
colored background

When the page is viewed using a browser, the browser will attempt to
load the specified URL into the frame.

VIEWING AND EDITING PAGES WITHIN FRAMESETS

Unlike many other Web page creation packages, Freeway allows you to
view and edit the contents of the pages viewed in a frameset, as long as
they are contained within the same Freeway document and do not
themselves contain framesets. This offers great advantages for designing
your site, since you can see what the finished result will look like without
having to constantly switch in and out of a Web browser to preview
changes.

The edge of the source page viewed within a frame is indicated by
means of a dotted line, which is visible while the View/Item Frame menu
option is turned on. You can create, move or delete objects on the
source page, type text, or change page attributes using the Inspector
palette, just as if it was the current page in view instead of the frameset
page.

You can also view other pages in your document through any frame,
without setting them as the source page for the frame. To do this, select a
frame or something on a page viewed within a frame, and hold down the
Command key while you choose another document page from the
popup page menu at the foot of the document window.

To create a further frameset within a frame:

You need to do this in order to add frames of a different orientation
from the other frames in the window.

1. Select the frame by clicking inside it. A selection marquee appears
inside the selected frame.
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2. Choose Split Vertical or Split Horizontal from the Page menu. A nested
frameset will be created in the frame, dividing the frame into two
parts. Each of the two new frames can either be given a source, or
subdivided further using the Split Horizontal or Split Vertical com-
mand.

To add more frames at the same level:

1. Select one of the existing frames.

2. Choose Insert Frame from the Page menu.

A new frame is added to the same frameset as the selected frame.

Using the mouse to add frames:

It’s also possible to add frames using the mouse, by holding down the
Option key on the Keyboard as you drag from the edge of a frame.

• Option-dragging the dividing border between two frames in the
same frameset will add a new frame at the same level.

• Option-dragging the border between a frame and the edge of the
window will add a new frame in the same frameset or create a new
frame in an enclosing frameset.

To change the orientation of the frames in a frameset:

1. Select the frameset, or a frame within it.

2. In the Frames panel of the Inspector palette, use the Vertical checkbox
to specify whether the frames should be vertical (Checked) or
horizontal (Unchecked).

To remove a frame:

1. Select a frame.

2. Either choose Delete Frame from the Page menu, or press the Delete
(or Backspace) key on the keyboard. The selected frame will be
deleted.

If you have only two frames, deleting one will delete the frameset
altogether, and revert the page from being a frameset page to a normal
one. If you attempt to delete one of the only two frames defined for a
frameset page, Freeway will display a dialog box asking you to confirm
your choice.
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Selecting frames

To select a frame, you may do so by clicking within it using the Selection
tool. You may also select frames using the Frames palette. In both the
document window, and the Frames palette, clicking on a frame will select
that frame. Clicking on the border between two frames will select the
frameset, which contains those frames. Clicking on the outer border of
the frames around the edge of the document window, or the Frames
palette, will select the outermost or top level frameset defined for the
page.

Only one frame or frameset may be selected at any one time.

TIP: Using the Frames palette, you can select the enclosing framesets of

a frame by option-clicking on the selected frame until the frameset you

want is selected.

Deselecting frames

To remove an active frame selection, you can hold down the Shift key
while clicking inside the selected frame. In addition, clicking and dragging
with the mouse on an empty part of the page viewed within a frame will
deactivate the frame selection, as will selecting an object on the page
viewed inside the frame.

Using the frames palette

The Frames palette can be of great assistance in seeing the structure of
your framesets. It shows how the various framesets on your page are
nested, and the orientation and number of frames within them. Put
another way, it is a schematic view of your frame set that will allow you
to see how your frames and frame-sets are organized. The dimensions of
the frames & framesets shown in the Frames palette do not reflect the
actual dimensions that are specified.

This palette will show the currently selected or active frame and the
name of the frame if any. When you have the frame itself selected, the
palette shows the selected frame in dark gray instead of light gray.
However, if your current selection is an object or text contained on the
page being viewed through the frame, then the active frame in the
Frames palette is indicated using a gray, diagonally striped pattern.
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NOTE: It is also possible for the source page to be the focus for keyboard

commands without any objects or text being selected on it - this happens

when you drag using the selection tool on the page, but no objects are left

selected. This is a useful shortcut to make the Page Panel for the source

page appear in the Inspector palette at the same time as the Frameset

Page panel. When the source page is the focus in this way, the diagonally

striped pattern shows this in the Frames palette.

You can also use the palette to select individual frames or framesets.
Clicking in a frame shown in the palette will select the frame. Shift-
clicking will toggle the selection on or off. Option-clicking in turn will
select the successively enclosing framesets. You can also select a frameset
using the palette by clicking on the border between the frames them-
selves, or between the frames and the edge of the palette.

Sizing frames

Whether the frame border is visible or not, you may resize any frame
while working in Freeway. You can either use the mouse, or type in
numeric values to size a frame. Because frames are the result of splitting
the document window, and not objects in their own right, resizing one
frame will always affect at least one other in the frameset. Regardless of
whether you use the mouse, or type in values to size frames, each frame
may have its dimension specified either as a proportion of the overall
dimension of the frameset that contains it, or as a fixed size in points.

Frames are always initially created using proportional values to specify
their dimension - this means that their actual size when viewed will
depend on the current size of the browser window. When a visitor
resizes the browser window, the size of the frames will also change. If a
frame becomes too small to display all of the content viewed within it, it
will display scroll bars to allow the rest of the content to be viewed. It is
possible to set a frame so as not to display scroll bars if there is more
content than can be viewed in one go. You can also set the frame to use
a fixed value for its dimension instead of a proportional one, using
instructions below.
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If you set all the frames to be fixed sizes, in practice this will be overrid-
den by the browser’s current window size, and the result may be
unpredictable. The size of a browser window can’t be changed using
specifications in a Web page - only by resizing using the mouse. The only
exception to this is when a new window is “spawned” from a current
page using JavaScript commands - the dimensions of the new window
can be set as it is spawned.

It is also impossible to prevent the existing browser window from being
resized by the visitor. For these reasons, you should take into account the
different sizes that the browser window may be sized to, and allow for at
least one of your frames to be a flexible size. Taking flexibility into account
(and even making it work for you) is one of the key steps to becoming a
skilled Web page designer.

Interactive resizing of frames

When the frame borders are visible in the browser window, by default
the visitor is able to use their mouse to resize the frames and affect their
viewing experience. When using frames for layout or design purposes,
this is often undesirable, and it is possible to set frames so that the visitor
can not resize them. In most browsers (though not all), hiding the frame
borders by setting the Border value to 0pt in the Frameset Page panel
will prevent the visitor from resizing the frames in any case.

Although most of the time you will want to make your frames so they
cannot be resized by the visitor, there are occasions when allowing this
will be a perceived as a generous concession. For example, some sites
that use a frame to display advertising banners allow the frame to be
made smaller - in effect hiding the adverts. This may be perceived
negatively by advertisers, but is the kind of touch that visitors appreciate
and which leads to higher revisit rates, which benefits both you and the
advertisers.
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Sizing frames using the mouse:

1. Move the mouse to the edge of a frame. The cursor will become a
double-headed arrow, even if the frame borders are set to Opt. If it
is hard to see where the edge is, click in one of the frames to bring
up the selection marquee - this will indicate where the edge is and
assist you in resizing the frame.

2. Drag to resize the frame as desired.

To size a frame using a numeric value:

1. Select the frame you wish to size.

2. In the Frames panel of the Inspector palette, type the value you
require into the Size text field. By default, the value you enter will be
specified as a percentage of the size of the enclosing frameset - this
means that the size of the will be proportional to the current size of
the browser window.

Setting frame size to be a fixed value:

1. Select the frame

2. In the Frames panel of the Inspector palette, use the popup menu
beside the Size option to change the units from percentages (%) to
points (pt).

This will set the frame to always appear with a fixed dimension if possi-
ble.

Setting frame size to be completely flexible:

If you wish to set a frame so that it will be completely flexible in size,
setting the other frames in the same frameset to be fixed values, and
leaving this frame set as a percentage or proportional value, will effec-
tively achieve this result. However, it is also possible to explicitly set the
frame as being a completely flexible size:

1. Select the frame.

2. Uncheck the box beside Size in the Frames panel of the Inspector
palette.

In the HTML output, the size for this frame will now appear as an asterisk
(*) rather than as a percentage value (e.g. 76%).

Making frames that can’t be resized when viewed:
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2.6 TABLES

INTRODUCTION

Tables in Freeway allow you to organize and present tabular information
- that is, information that is naturally presented in rows and columns -
correctly and easily. Occasions when tables are useful for presenting your
content include the display of price lists, schedules, product features and
so on.

A table consists of a collection of rectangular “cells”, laid out side by side
to form rows and columns. When you create a table in Freeway, you will
be asked to specify the number of rows and columns you want the table
to contain. Once you have created a table, you can adjust the width and
height of the cells in the table, and enter text into them.

Tables within Freeway are classed as an HTML element, which means
that tables behave in a similar manner to HTML text boxes, pass-through
graphics or form controls. Just like form controls in Freeway, tables can’t
have other elements overlapped on top of them, and can cause graphic
elements which underlie them to be cut up.

When first created, all the rows in the table will be the same height, and
all the columns will be the same width. Once you have created a table,
you can then resize the individual rows and columns as you wish within
the overall dimensions of the table. You can add or remove rows or
columns at any time.

Like other HTML items, the vertical height of a table on your page may
increase when the page is viewed in a Web browser, owing to factors
such as the default text size in the visitor’s browser being larger than
usual. Using tables in complex layouts requires the same care as the use
of HTML text boxes or form controls, as they can expand and potentially
cause elements on your page to break or shift when the page is viewed.

As well as the number and relative sizes of the rows and columns in the
table, you can also control other aspects of how the table is displayed.
These include the presence and thickness of a border between the table
cells, fill color to be applied to the table or cell background, and the
vertical alignment of the contents of the cell.



49
1. INTRODUCTION 2

1.1 ABOUT FREEWAY 1.0 2
1.2 NEW IN 2.0 3

2. NEW FEATURES
2.1 HTML 4.0 LAYERS 8
2.2 CSS TYPOGRAPHY 17
2.3 FREEWAY ACTIONS 22
2.4 HTML IMPORT 28
2.5 FRAMES 30
2.6 TABLES 48
2.7 ANCHORS 61
2.8 UPLOAD 66
2.9 FLEXIBLE LAYOUT 75
2.10 INLINE ITEMS 82
2.11 SEPARATE RESOURCE

FOLDERS 84
2.12 PNG SUPPORT 86
2.13 DISTRIBUTE COMMAND 88

Freeway 2.0 NFG - Version 1.0. 17th July 1998

FREEWAY 2.0 NEW FEATURES GUIDE

You can also choose to merge two or more adjacent cells in a table into
a single cell, which gives even more flexibility in presenting and arranging
the information contained in your tables.

CREATING TABLES IN FREEWAY

Tables may be created in Freeway using the Table drawing tool, or by
choosing the Table command from the Insert menu. Using either method,
you will be asked to specify the number of rows and the number of
columns that you wish your table to contain.

Creating a table using the Table tool
To draw a table using the table tool:

1. Select the Table tool in the Tools palette.

2. Click and drag diagonally on the page to define a rectangular area. This
area defines the size and position for the new table.

3. In the Table dialog which appears, enter numeric values for the number
of rows and columns you wish the new table to contain, and click
OK. You can change the number of rows or columns at a later stage
if you wish.

4. A new table with default attributes will appear fitting the area you
defined by dragging with the table tool, as an independent item on
the page.

The rows and columns are evenly spaced to fit the size of the table.

Creating a table using the Insert menu.

Using the Table command on the Insert menu, you can create a table as
an independent item on the page.

To create a table as an independent item using the Insert menu:

1. Ensure that there is no text selection or text insertion point currently
active.

2. Choose Table from the Insert menu. The Table dialog will appear.

3. In the table dialog, enter numeric values for the number of rows and
the number of columns that you wish the new table to contain, and
click OK. You can change these settings at a later stage if you wish.
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4. A new table with default attributes will appear in the center of your
current document window as an independent item with a default
size. The rows and columns are evenly spaced to fit the size of the
table.

MODIFYING TABLES

There are a variety of options that can be specified for tables and their
cells. To access most of these, Freeway offers two new panels in the
Inspector palette - the Table panel and the Table Cell panel. The Table
panel is available whenever you’re working with tables, and the Table Cell
panel is available whenever you’re working with table cells or their
contents. There are also commands related to working with tables on the
Item and Insert menus.

You can control the following options for tables:

• Position

• Size

• Number of rows and columns

• Cell, Row or column sizes

• Border widths

• Cell Spacing

• Cell padding

• Cell & Table background color

• Join/Split cells

• Vertical alignment of cell contents

Positioning tables

Tables can be moved and positioned like other independent objects on
the Freeway page either by dragging with the mouse or numerically using
the Inspector palette.

To position a table using the mouse:

1. Using the selection tool, point to the border of the table until the
cursor changes to a hollow pointer.
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2. Click and drag to move the table to a new position. A dotted outline
indicates the position of the table while you are dragging it, and the
Inspector palette Item panel will show you the co-ordinates of the
table as you drag it around the page.

3. Release the mouse when the table is positioned correctly.

NOTE: You can drag from any part of the table by holding down the

Command key as you click to begin dragging.

To position a table numerically:

1. Select the table.

2. In the Inspector palette Table panel, use the X: and Y: values to enter
the offset across and down from the top left corner of the page to
the top left corner of the table. You can press the Tab key while you
are editing to move between fields in the Inspector palette, and
press Return when you are finished to accept the changes.

Resizing tables

Tables may be resized by dragging with the mouse, or by entering a new
width and height using the Inspector palette.

It’s important to note that many of the actions performed on individual
rows, columns or cells in the table may also affect the overall size. For
example, the endmost column or bottommost row may be resized by
dragging the left or bottom edge of the table, and this will affect the size
of the table as a whole.

To resize a table using the mouse:

1. Select the table so that the edge and corner handles appear.

2. Using the Selection tool, point to a handle so that the cursor becomes
a tail-less black pointer.

3. Click and drag to resize the table. All the rows and columns in the
table will be resized in proportion.

To resize a table using numeric values:

1. Select the table.
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2. In the Inspector palette Table panel, use the W: and H: values to enter
new width and height for the table. You can press the Tab key while
you are editing to move between fields in the Inspector palette, and
press Return when you are finished to accept the changes.

Selecting Table Cells

When working with cell background color or when joining and splitting
cells in your table, you need to be able to select the cells you wish to
work with. In addition, when joining cells which have different content or
background color, you need to be able to specify which cell’s settings are
retained.

Freeway allows you to select one or more cells in the table, even if the
selected cells are not adjacent or touching. When selecting more than
one cell, the first cell selected is marked as the target cell in the selection.
If performing the Join Cells command, it is this cell whose settings and
content will be used as a basis for the new span (see Joining and Splitting
Cells below for more explanation of what a span is).

When more than one cell is selected, the target cell is shown using a
thicker inverted outline, and the rest of the cells in the selection are
denoted by a moving selection border (also known as “marching ants”).

Freeway also allows you to select entire rows or columns quickly by
clicking at the top or left-hand edge.

To select a cell:

1. Using the Selection tool, hold down the Command key on the key-
board and click on the cell you wish to select.

To select two or more cells:

1. Using the Selection tool, hold down the Command key on the key-
board and click on the first cell you wish to select. This cell will be
the master cell in the selection.

2. Now, hold down the Shift key in addition to the Command key and
click on the second and subsequent cells to be added to the
selection. The cells do not need to be adjacent.

NOTE: if you wish to remove a selected cell from the selection, Com-

mand-Shift-clicking again will deselect it while retaining the selection of
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any other cells.

To select an entire row or column:

1. Move the mouse over the top of a column or the left-hand edge of a
row until the cursor changes to a small solid arrow.

2. Click to select the row or column.

NOTE: Any cell spans will be selected only if they start in that row or

column.

Adding and removing rows, columns and cells

You can add or remove rows, columns or cells at any time. You can
change the number of rows and columns by editing the settings for the
table in the Inspector palette, or you can choose to insert or delete rows,
columns or cells at a particular point in the table.

When editing the number of rows and columns for the table, rows and
columns are added or removed at the lower and right hand edge of the
table.

When using the insert command, the new row, column or cell is added
before the target cell in the current cell selection (see Selecting Cells
above).

When removing rows, columns or cells, the selected row, column or cells
are deleted.

To change the overall number of rows and columns in the table:

1. Select the table, and view the Table panel in the Inspector Palette.

2. Using the Rows and Cols options, enter the number of rows and
columns you wish. You can press the Tab key while you are editing to
move between fields in the Inspector palette, and press Return
when you are finished to accept the changes. The table will be
updated to reflect your changes, and if any rows or columns need to
be added or removed, this will be done from the bottom right of
the table inwards.

TIP: Use this method when you wish to add or remove several rows or

columns in one go.



54
1. INTRODUCTION 2

1.1 ABOUT FREEWAY 1.0 2
1.2 NEW IN 2.0 3

2. NEW FEATURES
2.1 HTML 4.0 LAYERS 8
2.2 CSS TYPOGRAPHY 17
2.3 FREEWAY ACTIONS 22
2.4 HTML IMPORT 28
2.5 FRAMES 30
2.6 TABLES 48
2.7 ANCHORS 61
2.8 UPLOAD 66
2.9 FLEXIBLE LAYOUT 75
2.10 INLINE ITEMS 82
2.11 SEPARATE RESOURCE

FOLDERS 84
2.12 PNG SUPPORT 86
2.13 DISTRIBUTE COMMAND 88

Freeway 2.0 NFG - Version 1.0. 17th July 1998

FREEWAY 2.0 NEW FEATURES GUIDE

Adding and removing individual rows, columns or cells:

1. Select a cell or a range of cells in the table.

2. From the Insert menu, choose Row, Column or Cell as appropriate.
You may find that one or more of these options is not available at
present owing to the nature of the current cell selection - for
example, if you have an entire row selected, you will not be able to
insert a column at that moment and vice versa. The new row,
column or cell is added before the current selection.

TIP: When dragging the border between two rows or columns, you can

cause a new row or column to be created by holding down the Option key

on the keyboard while you drag and releasing it after you release the

mouse button.

Empty cells

In tables on the Web, cells may be defined as “empty” which means that
no cell is displayed at all at that location in the table - this is a distinct
option from an ordinary cell which simply has no content. For example,
empty cells do not display the border if one is applied to the table. You
can select any cell or cells, and cause them to be set to be empty cells, in
which case any existing content will be discarded.

Empty cells may be created incidentally while adding or removing rows,
columns or cells.

To set an empty cell:

1. Select one or more cells in the table.

2. In the Inspector palette Table Cell panel, turn on the checkbox beside
the Empty option. Any existing content will be deleted, and the cell
will show as a blank area in the table.

Resizing Rows and Columns

When you resize a row or a column using the mouse, you can choose
whether the adjacent row or column has its size changed as a result or is
simply repositioned.

You can also specify the size for rows and columns using numeric values.

To change the widths of rows or columns using the mouse:
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1. Using the Selection tool, point to the border between two rows or
columns so that the cursor changes to the resizing shape.

2. Click and drag to reposition the border and resize the row above or
the column to the left, as appropriate.

3. The adjacent row or column will be repositioned.

NOTE 1: You can cause the adjacent row or column to be resized as a

result, instead of repositioned, by holding down the Command key after

beginning to drag, and releasing it after releasing the mouse button.

NOTE 2: Rows and columns have a minimum size when empty, and can-

not be made smaller than this. If cells contain text, they cannot be made

smaller than the size required to hold the text. When a cell contains an

inline item, the cell contents will overflow if the cell is too small to dis-

play the whole item.

Changing table borders

When a table is displayed in a Web browser, it can be shown with “3-
dimensional” beveled borders around the edges of the cells and the
table. You can turn this border on or off, and specify its thickness. By
default, new tables created in Freeway are given a border with an 8pt
thickness.

To change the table border:

1. Select the table.

2. In the Inspector palette, enter a new numeric value in the Border
option in the Table panel, and press Return.

To remove the table border:

1. Select the table.

2. In the Inspector palette, enter 0pt in the Border option in the Table
panel, and press Return.

Changing Cell Spacing

The cells in each row and column may be separated by a certain amount
of space - this is called the Cell Spacing. By default, this is set to 5pt when
new tables are created in Freeway. Changing this option for the table will
cause the overall dimensions of the table to change.
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To change the Cell Spacing:

1. Select the table.

2. In the Inspector palette, enter a new numeric value in the Cell Spacing
option in the Table panel, and press Return.

To remove the Cell Spacing:

1. Select the table.

2. In the Inspector palette, enter 0pt in the Cell Spacing option in the
Table panel, and press Return.

Changing Cell Padding

Within each table cell, you can specify an offset between the inside edge
of the cell and the content of the cell. This offset is called the Cell
Padding. When new tables are created in Freeway, Cell Padding is set to
0pt by default.

To change the Cell Padding:

1. Select the table.

2. In the Inspector palette, enter a new numeric value in the Cell Spacing
option in the Table panel, and press Return.

To remove the Cell Padding:

1. Select the table.

2. In the Inspector palette, enter 0pt in the Cell Padding option in the
Table panel, and press Return.

Applying color

You can apply a colored fill to the background of the table or to indi-
vidual cells.

To apply color:

1. Select the table or a run of one or more cells.

2. Choose the color you wish to apply from the Table or Table Cell panel
in the Inspector palette as appropriate, or from the Color palette.
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Joining and splitting cells

It is possible to combine two or more cells together in order to define a
single new cell which spans two or more rows or columns. Cells created
in this way are called Spans, and can be used to create headings across
the table or to group categories of cells together. Spans can be split back
into an appropriate number of cells if desired.

To join two or more cells:

1. Select two or more cells as described above in Selecting Table Cells.
The first cell selected will be the target cell for the selection, and it is
the content and settings of this cell which determine those of the
new span cell which will be created.

2. Choose Join Cells from the Item menu. The cells will be combined into
one new cell, with the content and settings of the target cell in the
original selection.

NOTE: If the cells in the original selection were not adjacent cells in the

same row or column, then Freeway will create a new span cell which fits

the rectangle defined by the outermost cells in the selection.

IMPORTING CONTENT INTO TABLES

Table cells behave much like HTML text boxes, and are primarily in-
tended to contain numeric or text content. If you wish a table cell to
contain a graphic or other content such as multimedia, you need to
create an inline item in the cell to contain this.

ADDING TEXT

You can add text to a table cell by typing, pasting or importing.

When you add text, you are adding it to a single cell at a time. However,
there is a way of importing text into multiple cells using delimited text.
When you import tab-, comma- or space-delimited text into a table cell
in Freeway, Freeway will automatically put each delimited entry into a
separate table cell. Each line of text in the original text file becomes a
separate table row. When creating the text file for import in this way,
individual entries can be separated by putting tab characters, spaces or
commas between them in the original text file.
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 Adding text into a table cell:

1. Click inside a table cell using the Selection tool to create a text
insertion point.

2. To add text, either:

• Type the text you want to add

• Paste text from the clipboard

• Use the Import Text command on the file menu

As you add text into a table cell, it will wrap at the edge of the cell onto
a new line as required. If no more lines of text will fit in the table cell, the
cell will grow downwards to accommodate the text. This will normally
cause the whole row to become deeper.

To import delimited text into a table:

1. Create a text file in a word-processing document, using commas,
spaces or tabs to delimit each entry on a line.

2. Create a table.

3. Click using the Selection tool to create a text insertion point in the
first table cell which you wish to hold the content from the text file.

4. Choose Import Text from the File menu, and locate the text file you
wish to import. Click Open.

Freeway will import the contents of the file into your table. Freeway will
automatically put each delimited entry into a separate table cell. Each line
of text becomes a separate table row.

To import other content into a table cell:

1. Click inside a table cell using the Selection tool to create a text
insertion point.

2. Choose Graphic Item from the Insert menu to insert an inline graphic
item.

3. To add graphic or other non-text content:

• Choose Import from the File menu.

• Paste the content from the clipboard.

• Drag and drop the content from the Finder
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If the content imported is a graphic, the table cell will expand to fit the
graphic.
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2.7 ANCHORS

INTRODUCTION

Using links between pages, you can allow visitors to your site to navigate
from one page to another. When a new page is loading into the browser
window and it is longer than can be shown in the window, a scroll bar
will normally appear to allow the visitor to scroll down the page to any
point they desire.

This is usually exactly what is needed - however, on long pages it is often
useful to allow visitors to navigate directly to a particular point on the
page, rather than the top. Anchors provide a means of allowing this.

WHAT ARE ANCHORS?

An anchor is a means of marking a vertical location on a page, and this
location can then be referenced as a specific destination when you are
creating links to that page.

When someone follows a link that includes an anchor reference, the
destination page will load, and automatically scroll to the position of the
anchor if that location is not already visible in the window.

WHY USE ANCHORS...

Anchors are useful on long pages to enable you to send the visitor to
that page and automatically show them the information they need,
without making them read the entire page to find it.

You might also offer links at the top of a page that will scroll to headings
that appear further down. This can be used as a sort of dynamic table of
contents, to allow easier navigation within the current page.

It’s also common practice on long pages to offer links back to an anchor
at the top of the page. This way it is easier for the visitor to return to the
top when they have finished reading - these links are often found at the
end of each section in a long page, as well as at the foot of the page.
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HOW DO ANCHORS WORK?

At each vertical location on the page that is going to become a specific
destination, an anchor is defined. When you define an anchor, you do so
by giving it a name. Every anchor should be given a unique name, so that
no two anchors within the same page share the same name. Each anchor
can then be referenced as the destination of a link, using its name.

When anchors have been defined within a Freeway document, they will
be available when applying links to (or within) the page they are on. You
start by defining a link, which simply points to the page itself as normal,
but you then have the option to additionally specify any anchor that has
been defined within that page.

You can also link to anchors on external pages.

You can choose whether to give your anchors meaningful names relating
to the information they are attached to, or simply use a different letter or
number for each anchor. When defining anchors that will be linked to
from other pages, it’s usually a good idea to give your anchors meaningful
names. Although it’s often quicker and easier to simply use different
numbers or letters for the names of your anchors, meaningful names can
assist visitors as they navigate your site.

Meaningful anchor names help visitors to navigate because as the visitor
moves the mouse over a link in their browser, the destination of the link
will usually appear at the bottom of the browser window. This will display
the name of any anchor specified, and careful naming of anchors will help
the visitor decide whether they wish to follow the link.

For example, if you have some HTML text giving contact information at
the bottom of one of your pages, you can create an anchor on the text
and give it the name “contact”. You might link to this contact information
from other points on the page, or from other pages.

DEFINING ANCHORS WITHIN FREEWAY

In Freeway, you can place an anchor on any run of text, or on any graphic
item.

To define an anchor:
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1. Highlight the text or select the item you wish to bear the anchor.

2. Choose Anchor from the Edit menu to bring up the Anchor dialog

3. Type a name for the anchor.

4. Click OK

The anchor will now be available in the anchor popup menu when you
are defining links to that page.

Viewing and selecting anchors defined f or a page

To view the anchors in a document, bring up the Site palette and choose
Show Links from the Site palette popout menu. The links and anchors
defined on each page will appear listed below the page. Links are shown
in Roman type with an underline, whereas anchors are shown in italic
face. Clicking any link or anchor shown in the Site palette will select the
text or item which bears the link or anchor, and scroll that area of the
page into view in the document window.

To edit an anchor:

1. Highlight the text or select the item that bears the anchor.

2. Choose Anchor from the Edit menu to bring up the Anchor dialog. You
should see the name of the anchor displayed in the dialog.

3. Edit the name and click OK

The anchor will be updated with its new name, and all links in the same
document that refer to that anchor will be automatically updated to
reflect the change. If you have already linked to the anchor from outside
the document, you will need to edit these external links manually to
reflect the change.

To remove an anchor:

1. Highlight the text or select the item that bears the anchor.

2. Choose Anchor from the Edit menu to bring up the Anchor dialog. You
should see the name of the anchor displayed in the dialog.

3. Delete the name and click OK

The anchor will be removed, and will no longer show in the anchor
popup menu.
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NOTE: When working with anchors on text, if the text selection is not

exactly the same as it was when the anchor was defined, you may get

unexpected results when editing or trying to remove the anchor. If the

selection includes additional text which was not part of the original se-

lection, you will see a hyphen (-) indicating that there is a mixture of

attributes specified for anchor. Alternatively, if you do not select all the

originally highlighted text, the anchor will not be completely removed

from the page

LINKING TO ANCHORS

Within the same Freeway document

You can create links within Freeway by using the Hyperlinks dialog in the
Edit menu, or by using the popup menus at the bottom of the document
window. Using either method, you can link to any existing anchors on a
particular page.

Linking to anchors using the Hyperlinks dialog:

1. Highlight the text or select the item you wish to bear the link.

2. Chose Hyperlinks from the Edit menu to bring up the Hyperlinks
dialog

3. Using the scrolling list beside Existing Page, choose the page containing
the anchor you wish to link to.

4. Using the Anchor popup menu, choose the anchor on the destination
page that you wish to link to, and click OK.

The name of the anchor is shown in the status area at the bottom of the
document window after the title of the page containing it and a #
symbol.

Linking to anchors using the popup menus:

1. Highlight the text or select the item you wish to bear the link.

2. Using the links popup at the bottom of the document window, choose
the page containing the anchor you wish to link to. The anchors
popup menu, with an icon showing a page, will appear beside the
links popup.
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3. Using the Anchor popup menu, choose the anchor on the destination
page that you wish to link to.

The name of the anchor is shown in the status area at the bottom of the
document window after the title of the page containing it and a #
symbol.

To remove a link to an anchor:

1. Highlight the text or select the item that bears the link.

2. Either

• Select None from the Anchor popup menu at the bottom of the
document window to remove the link to the anchor, leaving a link to
the page

• Select None from the links popup to remove the link altogether

Removing items that have anchors attached to them:

When an item (or text) which bears an anchor is deleted, either directly,
or by a page/folder/master being deleted, a dialog will appear warning
you that all links to this item will be removed. Clicking OK will delete the
item and remove all links to it in the same document. Clicking Cancel will
leave your document unchanged.
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2.8 UPLOAD

INTRODUCTION

Freeway is able to upload your site automatically to your Web space,
whether you need to transfer the files across the Internet or just copy
the files across a network. If you’re going to upload files across the
Internet to your Web space, you will need to obtain certain information
and enter it into Freeway’s upload settings, so that Freeway will be able
to access your Web space directly.

Using the Upload command, Freeway automatically maintains your
remote site, ensuring that as far as possible it is an exact copy of your
local site destination folder. Freeway will clean up any files that it has
created and which are no longer required.

NOTE: When you have uploaded your site, it is a good idea to make a
backup copy of your local site destination folder, in case there is a
problem on the Web server which damages the online version of your
site. As soon as you modify your site in Freeway and use the Preview
command, you will have altered the contents of your local site destina-
tion folder, and it will no longer be an exact match of your remote site.
This is why you should back it up as a separate step after Uploading.

UPLOAD METHOD

A site can be uploaded by using either File Transfer Protocol (FTP) or File
Copy.  Use the Upload via popup menu in the Document Setup or
Upload dialog to specify which upload method you require.

A site located on a remote server, which can only be accessed over the
Internet (or using TCP/IP networking) has to be uploaded using FTP -
this will normally be the method to use if you rent or receive free Web
space from an Internet Service Provider (ISP).

A site located on a local volume (or on a server that is accessed using a
local network) must be uploaded using File Copy. This will normally be
the method to use if you have your own Web server, or you will be
publishing your site using your own computer and Personal Web Sharing
(or similar software).
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NOTE: FTP Upload requires Open Transport networking to be installed.
The FTP Upload option will be unavailable if Open Transport is not
present.

SETTING THE UPLOAD OPTIONS

Before you can use the Upload facility to update your active Web site,
you need to tell Freeway where this is located, the upload method you
wish to use, and possibly enter a Username and Password. You can do
this when setting up your site, or at any time afterwards, using the
Document Setup dialog. You can also do this the first time you choose
the Upload command.

The Upload settings are saved with your Freeway document. If you set
the Upload options, then save your file, they will be retained for future
sessions. You will need to enter the Upload settings again for every new
Freeway document you create.

To set the upload options as you create a new document:

1. Choose New from the File menu to create a new document. The
Document Setup dialog appears.

2. In the Document Setup dialog, set any site options you wish.

3. Specify the Upload settings you require using the options in the
Upload cluster.

4. Click OK to accept your choices and create a new document based on
these. The new Untitled document opens in its own window.

To set the upload options in an existing document:

1. Choose Document Setup from the File menu. The Document Setup
dialog appears.

2. Specify the Upload settings you require using the options in the
Upload cluster.

3. Click OK to accept your choices and return to the document.

To set the upload options the first time you choose the Upload
command:

1. Choose Upload from the File menu. The Upload dialog box appears.
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2. Specify the Upload settings you require.

3. Click OK to tell Freeway to proceed with updating your remote site.
The options you specify here will be retained and used the next
time you choose the Upload command, and will be saved with your
documents.

NOTE: If you will be creating a number of Freeway documents which will
all need to use the same Upload settings, you may wish to consider
saving a Freeway document which contains these settings as a template
using the Template option in the Save As dialog. Alternatively, choose the
Freeway document you wish to make into a template in the Finder,
choose Get Info from the File menu, and check the Stationery option.
Doing either of these and subsequently opening the template document
will cause Freeway to create a new Untitled document which is an exact
copy of the original, and contains the Upload settings.

UPLOAD OPTIONS FOR FTP

When you choose to upload your site via FTP using the “Upload via:”
popup menu, you need to specify the following options:

• Path

• Username

• Password

You may also choose whether to use Passive FTP Mode by checking the
box beside this option.

To find out the required information, if you do not know it already, you
must contact the administrator or technical support department respon-
sible for your Web space. If you are renting Web space, or receive it free
from an ISP, contact the support department there.

You need to know the exact path to your Web space, as well as the user
name and password required to access it. Sometimes the user name and
password will be the same as those used to authenticate your dialup
account, or you may require different ones.



69
1. INTRODUCTION 2

1.1 ABOUT FREEWAY 1.0 2
1.2 NEW IN 2.0 3

2. NEW FEATURES
2.1 HTML 4.0 LAYERS 8
2.2 CSS TYPOGRAPHY 17
2.3 FREEWAY ACTIONS 22
2.4 HTML IMPORT 28
2.5 FRAMES 30
2.6 TABLES 48
2.7 ANCHORS 61
2.8 UPLOAD 66
2.9 FLEXIBLE LAYOUT 75
2.10 INLINE ITEMS 82
2.11 SEPARATE RESOURCE

FOLDERS 84
2.12 PNG SUPPORT 86
2.13 DISTRIBUTE COMMAND 88

Freeway 2.0 NFG - Version 1.0. 17th July 1998

FREEWAY 2.0 NEW FEATURES GUIDE

Path

Freeway needs to know the location of the remote folder you wish to
upload your site to. This is specified using a path. An ftp path always
contains the name of an ftp server (e.g. ftp.softpress.com) and may in
addition include a reference to a particular directory or folder on that
server (e.g. homepages/~mydomain). Here is an example:

ftp.softpress.com/homepages/~fishworld

The path must be entered exactly - if there are any spelling errors, or the
/ symbol is confused with \, then the path will not work. Ideally, ask the
support department of your ISP to email or fax the information to you -
if they email it, you can then copy/paste the path directly into the
required field in Freeway. If you have to type the path yourself, take care
to type it exactly as specified.

TECHNICAL NOTE: The address for the ftp server may be in domain

name format as above or in IP format (e.g. 236.26.122.7). It can also

optionally include a port number (e.g. ftp.softpress.com:21).

User name

In order to complete the upload successfully, you must enter your user
name - once again, take care to enter it exactly as given. You can enter it
into the upload settings at the same time as you enter the path, or you
can leave this option blank. If you leave the user name field blank here,
then Freeway will ask for you to enter it the first time you use the
Upload command during a session, and the user name will not be saved
with your document. If you enter your user name here, then Freeway will
remember it from then on, and it will be saved with your document.
Normally, it’s best to enter it into the upload settings for convenience.
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Password

You must also enter your password before Freeway can upload your site,
but (as with the user name) you have the option of whether to enter it
into the upload settings, or leave the password field blank. If you enter
your password into the upload settings, then Freeway will remember it
from then on, and it will be saved with your document. This is less secure,
because anyone who gains access to your Freeway document will be
able to modify your active Web site using the upload command. If you
leave the password field blank, then Freeway will request the password
each time you use the Upload command in a session, and it will not be
saved with the document.

Passive FTP Mode

This is an FTP option that may result in faster uploads with some servers,
although not all servers allow this option to be used. Try turning it on to
begin with, and if the upload completes successfully then leave it on. If
you experience any difficulty, then turn it off.

UPLOAD OPTIONS FOR FILE COPY

The required options for File Copy are more basic than for FTP, as this
option simply copies the site files to a folder on a local volume or to a
folder located on a server on your network.

Path

Freeway needs to know the location of the destination folder into which
to upload your site. Click the Path button, and navigate to the folder you
wish to choose as your destination folder for upload. If this is located on
a server volume, you need to ensure that the volume is mounted before
you set this for the first time. Open the desired folder, so that its name is
shown in the “Destination folder:” button at the bottom of the dialog
box. When you are happy that this shows the right location, click the
“Destination folder:” button to accept it.

UPLOADING YOUR SITE

To upload your site:
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1. Choose Upload from the File menu. Freeway will open the Upload
dialog box, which will already be completed with the information (if
any) that you entered into the Upload settings in the Document
Setup dialog.

2. If necessary, enter or amend the information shown.

3. Click OK to proceed with the upload. Freeway will now publish the
site into the local site destination folder first, to ensure that this is
up-to-date with any changes made to your document. If you have
not already specified the local site destination folder, Freeway will ask
you to locate it before you proceed. You should not choose the
same folder as you are uploading to.

4. Before uploading, Freeway will ask for your name and password if you
have not entered these in the Document Setup or Upload dialogs. If
you enter your name and password at this stage, Freeway will
remember your name for the duration of the Freeway session, but
will ask you for your password each time you connect.

5. Freeway will now compare the files in the upload destination folder
with those in the local site destination folder, and upload any files
that have changed. It will also perform any housekeeping that is
required, removing old files or folders which are no longer needed.

NOTES: During the upload, Freeway displays a progress window to show

how many files remain to be processed. You can stop the upload at any

time by clicking the Stop button on the progress window. While uploading

is in progress you can continue to work on in Freeway or in other appli-

cations. It is possible to perform two or more uploads simultaneously if

you wish.

During the upload process, Freeway copies any files which have changed
since the site was last uploaded, and deletes any files which are no longer
needed. Files are also uploaded if they have been removed from the
server, or if their size and date does not match the size and date of the
uploaded files. Files are not uploaded if they have not been changed.
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The upload process is carried out as a background task, and the progress
window will stay open even if you bring other windows in front of it. You
can continue editing the document being uploaded, or work on a
different document, or switch to another application. You cannot publish a
document while it is being uploaded (the Publish option is disabled), but
you may preview pages if they have not been changed since the upload
was started (the Preview option is disabled for pages which have been
changed.)

Uploading can be stopped by clicking on the Stop button in the progress
window, or by pressing Escape when the progress window is at the front
of the screen.

The progress window displays the number of items which remain to be
processed (i.e. compared and possibly uploaded to or deleted from the
upload site), along with a progress bar and text showing the current
operation. Two or more sites can be uploaded at the same time.

If the progress window is hidden behind another window (such as a
document window), it can be brought to the front of the screen by
selecting it from the Window menu, where progress windows are listed
in a separate section. The progress window for the current document
can also be brought to the front of the screen by selecting the Upload
option in a document while the site is being uploaded.

If an error occurs while uploading a site, Freeway displays an alert
message in the progress window and brings it to the front of the screen
if it is not already the front window. If Freeway is not the front applica-
tion, it plays a system beep and flashes its icon in the Application menu.

A document cannot be closed inadvertently while it is being uploaded. If
you try to close it, Freeway will display an alert asking if you wish to stop
the upload. Similar alerts are displayed if you try to quit Freeway while a
site is being uploaded, or if an alert message has not been dismissed.

ERROR MESSAGES FOR UPLOAD

The following error messages can occur during FTP upload:

1. “Cannot connect because the FTP host name is invalid.”



73
1. INTRODUCTION 2

1.1 ABOUT FREEWAY 1.0 2
1.2 NEW IN 2.0 3

2. NEW FEATURES
2.1 HTML 4.0 LAYERS 8
2.2 CSS TYPOGRAPHY 17
2.3 FREEWAY ACTIONS 22
2.4 HTML IMPORT 28
2.5 FRAMES 30
2.6 TABLES 48
2.7 ANCHORS 61
2.8 UPLOAD 66
2.9 FLEXIBLE LAYOUT 75
2.10 INLINE ITEMS 82
2.11 SEPARATE RESOURCE

FOLDERS 84
2.12 PNG SUPPORT 86
2.13 DISTRIBUTE COMMAND 88

Freeway 2.0 NFG - Version 1.0. 17th July 1998

FREEWAY 2.0 NEW FEATURES GUIDE

The FTP server name is not a valid domain name or IP address. Check
that the host name is correct in the Document Setup Dialog.

2. “Cannot connect because the FTP host name could not be
resolved.”

Freeway could not connect to the FTP host. Check that the host name is
correct in the Document Setup Dialog. This may also indicate a general
problem with TCP/IP on the computer - you can check that TCP/IP is still
functioning correctly by attempting to send Internet email, for example.

3. “Cannot login because your user name has not been recognized.”

The FTP server does not recognize your user name. Check that it is
correct in the Document Setup or Connect dialogs.

4. “Cannot login because your password or user name is incorrect.”

The FTP server has not accepted your password. Check that your
password and user name are correct in the Document Setup or Con-
nect dialogs.

5. “Cannot read directory because of an FTP error.”

6. “Cannot change directory because of an FTP error.”

7. “Cannot create directory because of an FTP error.”

8. “Cannot delete directory because of an FTP error.”

9. “Cannot get working directory because of an FTP error.”

10. “Cannot delete file because of an FTP error.”

11. “Cannot rename file because of an FTP error.”

12. “Cannot upload file because of an FTP error.”

An FTP error occurred during a directory or file operation. Check that
the FTP path in the Document Setup dialog is correct. There may also be
a problem on the FTP server - it is sometimes worth waiting for ten
minutes before retrying. If the problem occurs with a particular file or
directory (as indicated in the Upload progress dialog), it may be because
the file permissions for this item (on the FTP server) do not allow it to
be changed or deleted.

13. “Cannot complete upload because of a TCP error.”
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A TCP/IP error occurred. Check the settings in your TCP/IP and Modem
control panels.
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2.9 FLEXIBLE LAYOUT

INTRODUCTION - FLEXIBLE LAYOUT, FRIEND OR FOE?

One of Freeway’s strengths lies in its creation of fixed layouts, which
reproduce your design as closely as possible on the Web, within the limits
imposed by HTML. When designing a page with Freeway, you can be
reasonably sure that the horizontal positioning and width of the various
items on the page will be reproduced accurately, no matter where or
how your page is viewed.

However, there can be a certain amount of flexibility in how the vertical
construction of the page may appear in the Web browser under different
viewing conditions. This uncertainty arises when using HTML text on a
Freeway page, as HTML text can expand or contract vertically depending
on the browser, the fonts available and the platform used to view the
page. If HTML text takes up more room than allowed for it, your layouts
can stretch vertically in unexpected ways.  The effect may be to break
your layout, and for the designer who wishes complete control over the
appearance of the page, this can be frustrating.

There are two approaches commonly taken by designers who find
flexibility interfering with their layouts. The first and understandable
reaction is often to turn away from the use of any HTML elements, and
to turn everything on the page into a graphic element. This has its
problems, though, and depending on the content to be presented, and
the function of the site, this may not be the best way of designing the
page.

The second approach is to learn how this flexibility works, and begin to
embrace it - to build flexibility into the page design, so that the page
reacts in a sensible way to changes in the viewing conditions and adjusts
correctly instead of breaking.

There are occasions when both of these approaches can be appropriate.
Part of learning about Web publishing is gaining an understanding of
considerations such as how much flexibility is inevitable, how to neutral-
ize the effect a flexible element may have on the rest of the page, and
when to exploit flexibility for design reasons.
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Only HTML items are flexible in themselves - graphic items can’t change
size. However, on a page that uses flexible items, the overall behavior of
the page becomes flexible and this can affect the positioning of graphic
elements when the page is viewed in a browser.

Another important aspect of designing pages for the Web using Freeway
is understanding that by default, Freeway creates fixed-width pages
where the position of the items on the page is fixed relative to the left
hand edge of the Web browser window. This means that if the browser
window is wider than the page you create in Freeway, there will be a
(sometimes large) gap between where the page items end and the edge
of the browser window.

Making pages that can expand to make better use of this space when
viewed in the browser is the main reason for setting HTML items to be a
flexible width. Beyond this, you should also bear in mind that the page
contents can be set to output centered in the browser window instead
of being locked to the left hand edge, or even right aligned in the
browser window. These additional page alignment options make a wide
range of flexible layouts easy to achieve.

FLEXIBLE ITEM BEHAVIOUR

There are two main ways to use flexible HTML items. First, HTML items
may be made flexible horizontally. This means that their width becomes
dependent on the width of the browser window, instead of a fixed width
in points. In effect, they stretch to take up unused room across the
browser window.

Flexible width items are not completely flexible - they have a minimum
size, determined by the actual width of the item on the page. No matter
how the browser window is resized, flexible width HTML items can
never be narrower (in terms of absolute width in pixels) in the browser
than they are defined to be in Freeway.
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Secondly, HTML items may be made flexible vertically. As discussed at the
start of this topic, HTML items are always flexible vertically to a certain
extent - they will normally occupy at least the height they are given on
the Freeway page, but if the contents grow, HTML items can always
expand vertically. Making an HTML item flexible vertically is therefore
changing the behavior of the item from being a fixed height which can
then grow to accommodate larger contents, to being a completely
flexible height which will grow or shrink to always fit the contents exactly.

DEFINING FLEXIBLE ITEMS

Only HTML items may be defined as being flexible.

Defining Flexible width for an item
To set an HTML item to have a flexible width:

1. Draw or select the item

2. In the Inspector palette, change to the Export panel

3. Check the box beside the option Flexible Width

4. When the page is output, your HTML item will now have a flexible
width and will adjust to the width of the browser window.

NOTE 1: Remember that flexible width items are defined with a minimum

width, and although they can appear wider in the browser than they are

on the Freeway page, they can never appear narrower.

NOTE 2: Browsers normally stretch cells which contain HTML text be-

fore they stretch other cells: two adjacent items will be stretched equally

if both or neither contain HTML text; otherwise the item which contains

the text will be stretched in preference to the other item. Browsers some-

times stretch non-flexible items that are next to flexible items. For exam-

ple, if a flexible-width item that does not contain any text is next to a non-

flexible-width item that does contain text, Explorer and Netscape will

stretch the non-flexible item in preference to the flexible item. Always

check that the behavior of your page matches your expectations by test-

ing it as much as possible.
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CAUTION: Flexible-width items can cause page layouts to be broken
horizontally, in the same way that increased browser font sizes can cause
layouts to be broken vertically. You can use nested tables to prevent
items from being separated.

CONTROLLING THE VARIABLE WIDTH OF ITEMS

You may wish to impose more control over the width of flexible-width
HTML items, for example to control the width of the item relative to the
width of the browser window. This can be somewhat tricky to achieve,
and requires a little experimentation to get right. It is important to realize
that your layout, and therefore the width of the flexible HTML item, is
controlled by a layout table in the output HTML. This table is drawn to
the width of the items on the page, not the width of the page as seen in
Freeway. This can lead to unexpected results if a flexible width item is the
rightmost item, for example, and you don’t want it to occupy all the
available space in the browser window. To control the output appearance
of flexible items as seen on the page, it is necessary to ensure that some
additional space is included in the output layout table. This technique can
be useful for creating a right hand margin beside HTML text in a variable
width item, for example.

To control the appearance of a flexible-width item:

1. Draw or select the item to have a flexible width

2. In the Inspector palette, change to the Export panel

3. Check the box beside the option Flexible Width

4. Draw another HTML item occupying the area between the right hand
edge of the flexible item and where you wish the layout table to end
(normally the right hand edge of the page).

5. When the page is output, your HTML item will now have a flexible
width and will adjust to the width of the browser window, but its
appearance will now seem proportional to its appearance on the
Freeway page.
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DEFINING FLEXIBLE HEIGHT FOR AN ITEM

To set an HTML item to have a flexible height:

1. Draw or select the item

2. In the Inspector palette, change to the Export panel

3. Check the box beside the option Flexible Height

4. When the page is output, your HTML item will now have a flexible
height and will adjust to fit the content within it.

As described above, this changes the way HTML items are presented in
the Web browser, so that they will shrink to fit their content (or the
content of adjacent items) when they are displayed in a browser.

Flexible height is very useful in cases where an item that contains HTML
text is followed by other items on a page. If the HTML item is given
flexible height, it will adjust to fit the size of its text at any browser font
size. This prevents browsers from displaying a gap between the HTML
text and any following items at small font sizes.

You should leave this option switched off if you want an HTML box to
occupy a fixed height. This will probably be the case with most HTML
boxes that do not contain any text.

NOTE: Items that do not have flexible height will always grow to fit their

content at large point sizes. Specifying the flexible-height option simply

causes them to shrink to fit their contents as well as grow.

HTML PAGE ALIGNMENT

As discussed above, by default Freeway creates fixed-width pages where
the position of the items on the page is fixed relative to the left hand
edge of the Web browser window. This means that if the browser
window is wider than the page you create in Freeway, there will be a
(sometimes large) gap between where the page items end and the edge
of the browser window. Another way of putting this would be to say that
Freeway creates pages that are left-aligned in the browser window.
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It is also possible to set the page contents to appear centered in the
browser window, or even right-aligned. These other options unlock a
whole range of exciting possibilities for your page designs. However, you
should avoid using these if the effect of your page design depends upon a
precise alignment with a page background image. Background images are
always left-aligned in the browser window, and this can’t be altered to
match the alignment of the page contents if you center or right-align
these.

To set a different page alignment:

1. Go to the page you wish to set the alignment for (you can also set this
on a master page).

2. From the Page menu, choose HTML Alignment. A dialog box appears.

3. From the Align Contents popup menu choose from the following, and
then click OK:

• Left - aligns the page contents with the left-hand edge of the
browser window

• Center - centers the page contents within the browser window

• Right - aligns the page contents with the right-hand edge of the
browser window

4. When the page is viewed in the browser, the contents will display using
the chosen alignment.

NOTE: The effect of changing this setting can’t be viewed in Freeway

itself. Changes are only reflected when the exported page is viewed in a

Web browser.

Any extra space between the items on the page and the edge of the
page will be removed as follows:

• Left-aligned pages - space on the right is ignored in the output

• Center-aligned pages - space on both sides is ignored in the
output

• Right-aligned pages - space on the left is ignored in the output
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The construction of the output layout table (and where space is added
or ignored) can be seen by choosing HTML Layout from the View menu
in Freeway - the edges of the output tables are shown in dotted lines.

NOTE: Right alignment of the HTML page is not supported in Netscape

Navigator 2.0
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INTRODUCTION

With Freeway 2.0, it is now possible to create items on the page by using
commands on the Insert menu, as well as by using the drawing tools
provided in the Tools palette. In addition, items on the page may now be
of two sorts, Independent and Inline.

When you create an item by drawing a box using one of the drawing
tools, the resulting item will always be an Independent item - this means
that it can be moved and positioned freely, anywhere on the page.

However, items created using the Insert menu can be added to the page
in two ways - as independent items, as above, or as inline items.

Inline items are items that have been inserted into a run of text in a text
box, and are embedded in the text. Inline items can’t be freely positioned
anywhere on the page - instead, they flow with the text within the text
box. This means that they offer a different range of layout possibilities -
for example, a graphic which is related to a piece of text can now be
embedded before or after that text in the same text box, so that it
moves with its adjacent text if the story re-flows. Inline graphic items also
allow text to be wrapped accurately around the graphic, which is not
possible using independent graphic items.

INSERTING INDEPENDENT ITEMS

You can use the Insert menu to create a new item on the page, instead
of using one of the drawing tools. When you create an item in this way, it
will appear in the center of the view in the document window.

NOTE: When the current page is a frameset page, the Insert menu com-

mands will only be available when working on a source page which is

being viewed through the frameset.

The items that can be created in this way are:

• HTML Item

• Graphic Item

2.10 INLINE ITEMS
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• Object

• Form control (Checkbox, Radio, Button, List, Text Field and Text
Area)

• Table

• HTML Markup

NOTE: Inline graphics are exported. Inline graphics within a graphic

frame are grouped with their parent frame, but inline items within an

HTML frame are not grouped.
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2.11 SEPARATE RESOURCE FOLDERS

INTRODUCTION

In Freeway 1.0, although it was possible to construct a structured site
where your site destination folder could contain sub-folders to hold
related pages together, any resources (such as graphics) which belonged
to each page had to reside at the same level as the HTML page.

Now, in Freeway 2.0, you can choose where you want the resources for
each page to be published to: your choices are

• In a common resource folder at the top level of the site

• In a separate resource folder in each folder of the site

• Loose in the same folder as the HTML page they belong to

Freeway 2.0 defaults to using separate resource folders.

This can make it easier to manage the output files for your site. It can
also help with performance during publishing, as splitting the resources
into separate folders can mean that there are fewer files in each folder
than there might otherwise be, and the Macintosh File System tends to
become sluggish when asked to manage large numbers of files in a folder.

When common or separate resource folders are specified for a site, any
graphics, movies, Java applets or other files used in your site will be
published into a folder called Resources, leaving the actual HTML files for
your pages together.

SPECIFYING THE RESOURCE FOLDER

The location for publishing page resources is set using the Document
Setup dialog. In the Site cluster, the Resources popup menu offers the
following options:

• Common Resource Folder: all resources are saved in a single “Re-
sources” folder in the root of the site folder.
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• Separate Resource Folders: resources are saved in separate “Re-
sources” folders in each subdirectory of the site folder, as well as in
the root of the site folder. This is the default option for new docu-
ments.

• With HTML Files: resources are saved in the same directories as HTML
files (as happens in Freeway 1.0).

NOTES:

1. If the ‘DOS File Names’ option is selected, the resources folder is named

“Resource” instead of “Resources”.

2. If a resource is shared by several pages in different folders, and the

common or separate resource folder options are selected, the resource

will be copied into a single folder and not duplicated in each of the sepa-

rate folders.

3. Separate Resource Folders was chosen as the default option because

the Mac file system can be slow at dealing with folders which contain

large numbers of files.

4. Freeway saves a single cleardot GIF in the resources folder that is in

the root of the site folder if the common or separate resource folder op-

tions are selected, or in the root of the site folder if With HTML Files is

selected

5. When Separate Resource Folders is selected, a resource folder may be

published but not contain any contents, if the pages in a folder do not

actually require any resources.



86
1. INTRODUCTION 2

1.1 ABOUT FREEWAY 1.0 2
1.2 NEW IN 2.0 3

2. NEW FEATURES
2.1 HTML 4.0 LAYERS 8
2.2 CSS TYPOGRAPHY 17
2.3 FREEWAY ACTIONS 22
2.4 HTML IMPORT 28
2.5 FRAMES 30
2.6 TABLES 48
2.7 ANCHORS 61
2.8 UPLOAD 66
2.9 FLEXIBLE LAYOUT 75
2.10 INLINE ITEMS 82
2.11 SEPARATE RESOURCE

FOLDERS 84
2.12 PNG SUPPORT 86
2.13 DISTRIBUTE COMMAND 88

Freeway 2.0 NFG - Version 1.0. 17th July 1998

FREEWAY 2.0 NEW FEATURES GUIDE

2.12 PNG SUPPORT

INTRODUCTION

The PNG (Portable Network Graphics) format was developed as an
alternative to GIF, and is supported by recent web browsers, with some
limitations (see below). The original impetus for developing PNG arose
when Unisys began to charge software developers for the use of LZW
compression. PNG also has other advantages over GIF, including:

• The ability to store images which contain millions of colors. GIF
images cannot contain more than 256 colors.

• Full alpha-channel transparency. GIF images support only two
levels of transparency, on or off. In PNG images, any color may be
opaque, partially transparent, or completely transparent.

• An interlacing option which allows a rough image to be displayed
sooner than with GIF interlacing.

• PNG compression often produces slightly smaller files than GIF
LZW compression.

On the other hand, PNG does not have animation options, and PNG
transparency is not supported by current web browsers or by
QuickTime 3 (see below).

In contrast to JPEG images, PNG images that contain millions of colors
do not lose quality when they are compressed, but they require much
larger file sizes. In normal circumstances it is better to use JPEG for
images which contain millions of colors (photographs and other continu-
ous tone images), and GIF or PNG for images which contain 256 or
fewer colors.

NOTE 1: Freeway does not currently support transparency in 32-bit PNG

images (images which contain millions of colors), except for pass-through

graphics. This is not a significant issue, since browsers do not support

transparency in 32-bit or 8-bit images, and 32-bit PNG images tend to be

too large for use on web pages.

NOTE 2: Freeway preserves partial transparency in 8-bit images when

they are manipulated within Freeway. E.g. when they are combined with
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other graphics, or placed in a colored box - but it does not export par-

tially transparent colors in non-pass-through images (the partially trans-

parent color is combined with its background color). Full transparency is

always preserved (in 8-bit images).

BROWSER SUPPORT

Some browsers which do not support the PNG format directly can
display PNG images if QuickTime 3 is installed. (E.g.: Microsoft Internet
Explorer 3.0.1)

PNG is directly supported by Netscape browsers version 4.04 and
upward.

IMPORTING PNG IMAGES

Freeway can import PNG images as editable graphics (in a gray graphics
box) or as pass-through graphics (in a blue HTML box). PNG images
which are imported as editable graphics default to GIF or JPEG format
when they are re-exported - PNG images with 256 or fewer colors
default to GIF format, and PNG images with millions of colors default to
JPEG format. Editable PNG images can be re-exported as PNG format if
the PNG format is selected in the Graphics Export panel of the Inspec-
tor palette (see below).

EXPORTING PNG IMAGES

An image is exported in PNG format if the ‘PNG’ option is selected in
the Export panel or Group Export panel of the Inspector palette.
Individual pages or selections can also be exported in PNG format via
the Export option.

PNG images have the same export options as GIF images, except that
they can also be exported with millions of colors (not usually a good
idea). Some options are only applicable to images that contain 256 or
fewer colors (dithering, palette, number of colors) - these are unavailable
if ‘millions of colors’ is selected.
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2.13 DISTRIBUTE COMMAND

INTRODUCTION

Freeway offers a variety of methods of automatically positioning both
new and existing objects. These methods include the following:

• Numerical positioning and sizing of individual page elements using
the Item panel of the Inspector

• Using the Item/Duplicate command to create replicas of the
selected items at a specific offset

• Using the Item/Align command to make selected items align using
their edges or centers

• Using the Item/Distribute command to space the selected items
apart

The Distribute command is new in Freeway 2.0, and becomes available
when you have two or more items selected on the page. Using the
Distribute command allows you to space the selected items in three
different ways:

• Space the selected items between the two endmost ones in the
selection

• Space the selected items across the page

• Space the selected items a specific distance apart

You can opt to distribute the selected items either vertically or horizon-
tally. In addition, you can distribute the selected items using their bounda-
ries, their centers, or particular edges.

When spacing items, you will normally want to have the distance be-
tween each item the same. However, there are occasionally situations
where you might not want evenly spaced items, but instead space the
selected items using their sides or centers. Examples of when this can be
useful include when items are different sizes but are visually “center-
heavy”, or when items are visually left-heavy or right-heavy.

USING THE DISTRIBUTE COMMAND

To use the distribute command:



89
1. INTRODUCTION 2

1.1 ABOUT FREEWAY 1.0 2
1.2 NEW IN 2.0 3

2. NEW FEATURES
2.1 HTML 4.0 LAYERS 8
2.2 CSS TYPOGRAPHY 17
2.3 FREEWAY ACTIONS 22
2.4 HTML IMPORT 28
2.5 FRAMES 30
2.6 TABLES 48
2.7 ANCHORS 61
2.8 UPLOAD 66
2.9 FLEXIBLE LAYOUT 75
2.10 INLINE ITEMS 82
2.11 SEPARATE RESOURCE

FOLDERS 84
2.12 PNG SUPPORT 86
2.13 DISTRIBUTE COMMAND 88

Freeway 2.0 NFG - Version 1.0. 17th July 1998

FREEWAY 2.0 NEW FEATURES GUIDE

1. Select the items on the page that you wish to affect.

2. Choose Distribute from the Item menu. The Distribute dialog will
appear showing a preview of how the current options chosen will
affect the selected items. You can choose from the following options:

• Direction (Horizontal or Vertical)

• Method (Across Items, Across Page, Fixed distance)

• Distance (in points - only available for Fixed Distance method)

• Between (Items, Top/Left Sides, Centers, Bottom/Right Sides)

3. When you are happy with the positions of the items shown in the
preview, click OK. The selected items will be affected as shown. If the
results are not quite right, you can choose the Undo command from the
Edit menu to revert the items to their previous positions, and try again.

SPACING SELECTED ITEMS EVENLY BETWEEN EACH
OTHER

To adjust the positions of the selected items so that they are evenly
spaced between the two endmost items in the selection:

1. Select the items on the page you wish to affect

2. Choose Distribute from the Item menu. The Distribute dialog will
appear showing a preview of how the current options chosen will
affect the selected items.

3. Use the Direction popup menu to choose whether you wish to space
the selected items vertically or horizontally.

4. Choose Across Items from the Method menu

5. Ensure the Between option is set to Items - this is normally the best
option to use.

6. Click OK. The selected items will be evenly spaced between the first
and last items in that direction.

NOTE: You can also choose to use the Between options Top/Left Sides,

Centers, or Bottom/Right Sides when you are spacing objects - however,

if the items you are working with are all the same size, these will all have

an identical effect.
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SPACING ITEMS EVENLY ACROSS THE PAGE

To adjust the positions of the selected items so that they are evenly
spaced across the page:

1. Select the items on the page you wish to affect

2. Choose Distribute from the Item menu. The Distribute dialog will
appear showing a preview of how the current options chosen will
affect the selected items.

3. Use the Direction popup menu to choose whether you wish to space
the selected items vertically or horizontally.

4. Choose Across Page from the Method menu

5. Ensure the Between option is set to Items - this is normally the best
option to use

6. Click OK. The selected items will be evenly spaced between across the
page so that the endmost items are aligned against the page edges
and the other items are evenly spaced between them.

NOTE: You can also choose to use the Between options Top/Left Sides,

Centers, or Bottom/Right Sides when you are spacing objects - however,

if the items you are working with are all the same size, these will all have

an identical effect.

SPACING ITEMS A FIXED DISTANCE APART

To space items so that they are a fixed distance apart:

1. Select the items on the page you wish to affect

2. Choose Distribute from the Item menu. The Distribute dialog will
appear showing a preview of how the current options chosen will
affect the selected items.

3. Use the Direction popup menu to choose whether you wish to space
the selected items vertically or horizontally.

4. Choose Fixed Distance from the Method menu

5. Specify the distance you wish to use in points

6. Choose the Between option you wish to use.
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• Items - the items are positioned so that the space between where
one item stops and the next one starts is the amount specified

• Left/Top Sides - the items are positioned so that the space
between the top of each item (when a vertical direction is chosen)
or the left side of each item (when a horizontal direction is chosen)
and that of its neighbor is the amount specified

• Centers - the items are positioned so that the space between the
center of each item and that of its neighbor is the amount specified

• Right/Bottom Sides - the items are positioned so that the space
between the bottom of each item (when a vertical direction is
chosen) or the left side of each item (when a horizontal direction is
chosen) and that of its neighbor is the amount specified

7. Click OK. The selected items will be positioned using the fixed distance
value specified


